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4 Editors dters

4.1 CFC Editor
4.1.1 CFC Editor, General Information

The CFC editor is used to program objects in the Continuous Function Chart
( ) language available in the standard languages of IEC 61131-3.

The programming language for a new object is specified when the object is
created using the

The CFC editor is a graphical editor.

The editor is located in the lower section of the window that opens when a
CFC object is edited.

The upper section contains the
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Fig.4-1: CFC editor

In contrast to the network-based editors, the CFC editor allows free

of elements which enables feedbacks to be inserted directly
for example. The processing sequence is determined by a list of the currently
inserted elements which can also be modified.

and are ready to
be added: Function block (operators, functions, function blocks, programs),
input, output, comment, label, jump, composition selector.

The input and output pins of the elements can be connected using the mouse
to draw a line between them.

The connection line is automatically created so that it covers the shortest
possible distance between the elements.

The connection lines are also adjusted automatically when an element is
moved. Also see:

The size of the working sheet is adjustable:

To do this, use the @ button in the lower right corner of the window and
select one of the zoom factors from the list. Alternatively, select the list en-
try ... to enter any desired factor.

Call the commands, page 268, to work in the CFC editor from the context
menu or the CFC menu available by default when the CFC editor is active.
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Editors

= The under Tools » Op-
tions » IndraLogic 2G » CFC Editor connects elements whose un-
assigned connections are in contact with each other.

4.1.2 CFC - Continuous Function Chart - Language

"Continuous Function Chart" is a graphical programming language, an exten-
sion of the IEC 61131-3 standard languages based on the

(FBD). However, in contrast to that language,
CFC allows the free positioning of elements to insert feedback for example.

To generate CFC program blocks in IndraLogic, see: CFC Editor.
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Fig.4-2: Example of a CFC network

4.1.3 Cursor Positions in CFC

In the CFC editor, possible cursor positions are indicated by default with gray
shading when the cursor is moved over the inserted elements.

Click on one of these shaded areas and hold down the mouse button. The
color of this area changes to red. When you release the mouse button, the
position becomes the current cursor position, i.e. the respective element is
selected and displayed in red.

There are three categories of cursor positions. In the following, the possible
positions that are not yet in use are each indicated by gray shading:

1. When the cursor is positioned on a text, it is displayed with a blue back-
ground and can be edited.

The [:' button can be used to open the input assistance. After the ele-
ment has been inserted, three question marks "?7?7?" appear to represent
the text. These have to be replaced by a valid identifier. Afterwards,
when the cursor is positioned on the name of a variable or a box param-
eter, a tooltip is displayed that contains the type of the variable/parame-
ter and a related comment in a second line if available.

I
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—IM o] [ <Enter your comment here. > ] <Enter your comment here...»
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Fig.4-3: Possible cursor positions and two examples of selected text in the
CFC

2. If the cursor is positioned on the body of an element (function block, in-
put, output, comment, label, jump, composition, selector), the body is
displayed in red and can be moved with the mouse.
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Fig.4-4: Possible cursor positions and an example of a selected function block

(box)

3. If the cursor is positioned on an input or output pin of an element, the
pin is displayed in red and can be negated, set or reset.
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Fig.4-5: Possible cursor positions and examples of selected input and output
pins

414 CFC Elements/Tools

The graphical elements for programming in the are in a toolbox.

The toolbox usually opens automatically in a window to the right of the work-
ing sheet when the CFC editor is active, but it can also be opened explicitly
using the command View » Tools
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= Comment

Fig.4-6: CFC fools, standard configuration

The desired element is selected in the toolbox and in the editor win-
dow via drag&drop.

In addition to the programming elements, there is also a "Pointer" entry, usu-
ally at the top of the tool list. While this item is selected, the cursor appears
as arrow and elements already inserted can be selected to and edit
them.
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CFC elements:
(=3 Input HE The text represented by "???" can be selected and re-
placed by a variable name or a constant. The input
= Output Y assistance can be used to select a valid identifier.

A function block element is used to insert an operator,
a function, a function block or a program. The "??7?"
have to be replaced by the name of the desired opera-
tor, etc. The input assistance supports the selection of
an available object.

For function blocks, "???" are also displayed above
e the function block symbol. These have to be replaced
. B with the name of the function block instance.

Function
o block (Box)

If the function block is inserted in place of an existing
function block (the existing function block is selected
and the new one inserted) and if it has a different min-
imum number of inputs, these are automatically add-
ed. If the function block has a lower maximum number
of inputs, the final inputs of the previously existing ele-
ment are deleted.

The jump element is used to specify a position at
which the program execution is continued. This posi-
= Jump =k tion has to be defined by a "label" (see below).

The "?7??" text has to be replaced as well with the
name of the label.

A label indicates a position to which the program exe-

Label 55 cution can jump using a jump element (see above).
In online mode, a RETURN label is automatically

placed at the end of a CFC function block.

Note that in online mode in the CFC editor, a RE-
TURN element is automatically placed in front of the
< TRETURN | first line and after the last element in the function
block. In step-by-step processing, a jump is made to
the RETURN element at the end before the function
block is exited.

= Retum

A composition element is used to handle inputs from a
function block of the type of a structure. The compos-
er displays the structure components and provides
them to the programmer in CFC. To do this, the com-
Ell} Composer T poser element has to have the same name as the re-
spective structure (replace the "???") and has to be
connected to the function block instead of to an input
element.
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1E Selector

—2?? —

In contrast to the composition element, a selector ele-
ment is used to handle the output of a function block
of the type of a structure. The selector displays the
structure components and provides them to the pro-
grammer in CFC. To do this, the selector has to have
the same name as the respective structure (replace
the "?77") and has to be connected to the function
block instead of to an output element.

= Comment

| <Enter pour comment here... > |

This element can be used to insert a comment in
CFC. Replace the placeholder text in the element with
the comment text. A line break can be added with the
shortcut <Ctrl> + <Enter>.

Function

E| block input

I

(Input Pin)

I3

Depending on the function block type, more inputs
can be added to an inserted function block element.
To do this, the function block element has to be selec-
ted and the function block input element has to be
dragged onto the function block body.

Function
~ | block output
(Output Pin)

Depending on the function block type, more outputs
can be added to an inserted function block element.
To do this, the function block element has to be selec-
ted and the function block output element has to be
dragged onto the function block body.

Example: Composer A CFC program cfc_prog
which has an input variable "struvar" of the type of a structure.

The composition elements can be used to address the structure elements.

uses an instance of the function block "fublo1"

Definition of structure "strut"

TYPE strul :
STRUCT
ivar:INT;
strvar:STRING:="hallo";
END_STRUCT
END_TYPE

Function block "fublo1", declaration and implementation:

FUNCTION_BLOCK fublol
VAR_INPUT
struvar:STRU1;
END_VAR
VAR_OUTPUT
fbout _i:INT;
fbout_str:STRING;
END_VAR
VAR
fbvar:STRING:="world";
END_VAR
fbout_i:=struvar.ivar+2;

fbout_str:=CONCAT (struvar.strvar,fbvar);
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CFC program "cfc_prog”, declaration and implementation:

PROGRAM cfc_prog
VAR
intvar: INT;
stringvar: STRING;
fbinst: fublol;

ergl: INT;
erg2: STRING;
END_VAR
fhirzt
fublol
inkyar v ar strul shrupear fbout_i ergl
stringwar strvar fbaut_str erge
Composer Function block with Inpat variable
stravar of bype structure sty
Fig.4-7: Example: Composer

A CFC program cfc_prog uses an instance of the function block "fublo2",
which has an output variable "fbout" of the structure type "stru1". The selector
elements can be used to access the structure elements:

Definition of structure "strui"

TYPE strul :
STRUCT
ivar:INT;
strvar:STRING:="hallo";
END_STRUCT
END_TYPE

Function block "fublo2", declaration and implementation:

FUNCTION_BLOCK fublo2

VAR_INPUT CONSTANT
fbinl:INT;
fbin2:DWORD:=24354333;
fbin3:STRING:="hallo";

END_VAR

VAR_INPUT
fbin - INT;

END_VAR

VAR_OUTPUT
fbout : strul;
fbout2:DWORD;

END_VAR

VAR
fbvar: INT;
fbvar2:STRING;

END_VAR

Program "cfc_prog", declaration and implementation:

VAR
intvar: INT;
stringvar: STRING;
fbinst: fublol;
ergl: INT;
erg2: STRING;
fbinst2: fublo2;
END_VAR
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Fig.4-8: Example: Selector

4.1.5 Inserting and Arranging Elements

Insert

Selecting

Creating boxes (function blocks)

Moving

Linking

Copy
Editing text

Deleting

for programming in the CFC editor can be accessed
in the toolbox which opens in a window by default when the CFC editor is ac-
tive.

To insert an element, select it by clicking on it in the tools window, then hold
down the mouse button and drag it to the editor window. While dragging the
element, the cursor appears as arrow with an attached rectangle and plus
sign. After the mouse button has been released, the element is inserted.

To select an element to edit or move it for example, note the possible

in the element body, on the inputs or outputs or in the
text. The element is selected by clicking on the body and it is displayed in red
by default.

By pressing the <Ctrl> key, other elements can be selected additionally. Al-
ternatively, hold down the left mouse button and draw a dotted frame around
the elements to be selected. The elements are displayed as "selected" when
the mouse button is released. Use the "Select all" command, located in the
context menu by default, to select all elements simultaneously. The arrow
keys can be used to move the highlighted selection to the next possible cur-
sor position. The sequence depends on the processing sequence of the ele-
ments indicated by the element numbers; see below.

If an input pin is selected and <CTRL> + <left arrow> is pressed, the respec-
tive output pin is selected. If an output pin is selected and <CTRL> + <left ar-
row> is pressed, the respective output (can also be multiple) is selected.

To replace an existing box, it is sufficient to replace the currently inserted
identifier with the desired new name. Consider that the number of input and
output pins is adjusted according to the definition of the POUs. This causes
that the existing assignments can be deleted.

To move an element, select it by clicking on the body (see possible

) and then hold the mouse button down while dragging it
to the desired position. After the mouse button has been released, the ele-
ment is inserted at that position. Alternatively, use the "Cut" and "Paste" com-
mands.

Use the mouse to draw connection lines between outputs and inputs of ele-
ments. The shortest possible connection is created, taking existing elements
and connection lines into consideration. If a connection line is displayed in
light gray, it is covered by another line.

To copy an element, select it and use the "Copy" and "Paste" commands.

After an element is inserted, the text section is represented by "???". To re-
place this placeholder with a valid identifier (name of a POU, a label, an in-

stance, etc.), click on the text to select it and open an input field. The [3
button can also open the

A selected element can be deleted with the "Delete” command located in the
context menu by default or with the <Del> key.
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Execution sequence, element  The sequence in which the elements of a CFC network are executed in on-
numbers  |ine mode is indicated by the element numbers in the upper right comer of
each element (function block, output, jump, return, label). The processing be-

gins with the element with the lowest number, "0".

The execution sequence can be modified using loca-
ted by default in the "Execution sequence" submenu in the CFC menu.

The execution sequence has to be set according to topological arrangement
or data flow.

When inserting an element, the number is automatically assigned in topologi-
cal sequence (from left to right and from top to bottom). If the sequence has
already been modified, the new element receives the number of its topologi-
cal successor and all of the higher numbers incremented by one.

When an element is moved, the number remains the same.

= Remember that the sequence affects the result and has to be
changed in certain cases.

L Ton TOF
:I— TH:
Fig.4-9: Example of element numbering

Changing the size of the working  To create more space in the editor window around an existing CFC chart, the
sheet in the editor window  sjze of the workspace ("working sheet") can be changed. It can be changed
all elements with the mouse or with the

"Cut&Paste" commands (see above).

Altematively, use a special dialog to specify the dimensions of the working
sheet. This can be useful for very large charts.

( ).
4.1.6 CFC Editor in Online Mode

In online mode, the CFC editor provides views for and for

variable values from the control. Debugging
functionality (breakpoints, step-by-step execution, etc.) is available. See be-
low.

Note that the editor window for an CFC object also contains a declaration edi-
tor in the upper section.

Monitoring  The current variable value is displayed in a small window behind the variable
(Inline monitoring).
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Breakpoint positions in the CFC
editor:

Editors
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Fig.4-10: Example: Online view of a program PLC_PRG

Note for the online view of the function block that monitoring is only possible
in the view of an instance. No values are displayed in the view of the basic
implementation. Instead, the "Value" column contains the text "<The value of
the expression cannot be read>" and three question marks appear in the re-
spective Inline monitoring fields in the implementation section.

at the positions in a function block at
which a variable value can change or where the program sequence branches
or another function block is called. The red circles in the following figure show
possible breakpoint positions:

]
28 & 2
L =
|

23

B

Fig.4-11. Breakpoint positions in the CFC editor
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= A breakpoint is automatically set in all that can
be called.

Thus, the following applies: If a method defined by an interface is
called, breakpoints are set in all methods of function blocks that
implement this interface and in all function blocks derived that de-
fine the method.

4.2 Data Source Editor
4.2.1 Data Server, Overview

to set up a point-to-
point connection between this application (on the local device) and a remote
data source.

This way, data, i.e. variables provided by other devices (not currently possi-
ble) from OPC servers can be in the local application for example.

Several different data sources can be assigned to one data server.

= The data server does not replace the network variable functionali-
ty used in IndraLogic 1.x.

It only allows another type of data exchange.

Based on defined variable lists, network variables are exchanged
in broadcast mode.

= Bit accesses used in visualizations that are executed using a data
server connection, only function if they contain literal offset speci-
fications (i.e. no defined constants).

A data server in the Project Explorer as object below an
application. Only one data server may be set up per application. The neces-
sary data server libraries are automatically integrated into the project.

The data source(s) that the data server should manage, has to be as
objects below the data server.

The data source editor provides dialogs for the indi-
vidual data sources.

The following will be configured:

®  The variables to be considered |

® The types of access to be possible

®  The settings to communicate with the data source

422 Configuring a Data Source

can be configured with re-
gard to the selection of variables and the communication with the actual data
source.

Open the configuration dialog either with "Open" or by double-clicking on the
data source object in the Project Explorer.

The dialog has two tabs: Data Source Items and Communication.
Data Source ltems
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Fig.4-12:
Here, specify which variables from the remote data source can be used in the
local application and which access rights apply in that case.

"DataSource” dialog, Data Source lfems

= Bit accesses used in visualizations that are executed using a data
server connection, only function if they contain literal offset speci-
fications (i.e. no defined constants).

All data source items are displayed in the Provider Data ltems window. Use
the Refresh button above the item list to refresh the display. Code has to be
generated for the respective application in advance so that the list of items
can be created!

If the Structured view option is enabled, the items are displayed in a tree
structure. Otherwise, they are displayed non-hierarchically in a "flat" arrange-
ment. The function blocks and variables used by the data source application
appear in the "Application" node. If function blocks and data types are instan-
tiated in that case, they and their components are displayed below the "Data
Types" node. Note that the data type function blocks are not displayed in a
flat arrangement!

If the Show documentation option is enabled, a description of the currently
selected variable appears in the Documentation window if provided by the
data source.

To select the variables that the local application is supposed to access:

Select the variables in the "Provider Data ltems" window and either double-
click or use the > button (individual items) or the >> button (all items) to
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be used to remove the items from the list again.

In the Structured view, limit the selection to certain function block compo-
nents if there are function blocks and data types. Proceed as follows:

In the "Provider Data Items" window, select the desired variables in the "Ap-
plication" node. If instances of function blocks and data types are included, all
components are automatically provided as well. If this is not desired, sharing
can be limited to certain components by selecting them explicitly in the "Data

) Types" node.
Example of component selection
Provider Diats Tbems: Selected Data Items:
Refresh Ttem Access rigl
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Fig.4-13: Example of component selection

Accessrights By default, "read and write" access rights are assigned for each variable at
first; see the Access rights column. To change access rights to "Read-only",
click on the icon in this column to select it and click again to "switch" it.

"Read and write" icon: ™

"Read-only" icon: " #

Read: The variable is updated in the local application with its current value in
the data source as soon as its value in the data source changes.

Write: The variable is updated in the data source with its current value in the
local application as soon as its value in the application changes.
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By default, the selected variables are always only updated in the currently ac-

tive visualization. If a variable is also used in another function block in the ap-
plication, is has to be updated explicitly there using the corresponding func-
tion of the data server interface. (In this case, please contact your current

software supplier).

The Update by default button can switch between selecting and deselecting
all variables and the manual selection of individual variables. The selected

variables are updated each cycle.

= Note that for each variable with the enabled option Update by de-
fault, data is permanently exchanged between the data source

and the PLC on which the data server runs.

This can decrease the refresh rate of the variables if this option is

enabled for too many variables.

Communication
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Fig.4-14. "DataSource” dialog, communication paramefers
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Here, configure the parameters to communicate with the data source on an-

other device. Note the related information stated above.

1. Enter data source device: Specify either a fixed address or criteria for

the current search for an available control.
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Editors e  Click on "From Device" to automatically enter the data from the respec-
tive, currently connected data source device as configured in the

o  Fix target device address: If this option is enabled, the communication
takes place using the address entered here. Enter the address of the
device where the data source is located either manually or using "From
Device".

o Apphcatiorr [ataServer] DataSource_BRC_Contiol_2[BRC_MotionControl_1: Logic: Application: DataServer]

D'zt Source e Commarscation |

Tapsd deves
W Futaget devics addiess: | 0154 Erom Device
[ &

sxch i izgs doecs

Fig.4-15: Example for entering the address of the dafa source device

e  Search for target device: Instead of using a fixed address (see above),
do a current search for a control. To do this, define certain search crite-
ria (by placing checks):
— Node name: e.g. WST06
—  Target system type: Control type number, e.g. "4096"
—  Target ID: e.g. "0000 0001"
—  Target Version: e.g. "1.0.0.0"

—  Network location: Select the location of the target device from the
list:

Direct child of the data server PLC: In this case, the runtime sys-
tem that operates the data server has to provide a switching node
that the IEC can access. In addition, the preprocessor constant
CMPROUTER_AVAILABLE has to be set in the description file of
the device on which the data server is located to signal possible
use of the router library.

Direct child of the node with address: If this option is selected, en-
ter the address of the father node in the additional field that ap-
pears.

Direct child of the data server PLC or of the node with address:
This selection combines both options. Enter the address of the fa-
ther node in the additional field that appears and note the related
requirements at the router (see the first option).

- Search mode: Select a search mode from the list:

First device found: The first control in the device tree that meets
the criteria is used.

Exactly found device: Only a control that exactly meets the criteria
entered is used.

2. Setting the transfer parameters:

Login configuration: Select one of the following options from the list to
manage the login on the target device and the credentials required:

o Login using the following credentials (empty user/password is ok if
there is not user management on the PLC):

Credentials required by the target device has to be entered in the
User name and Password fields. If the target device does not have
user management, the fields can be left empty.
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o Login with credentials defined during runtime: Editors

Select this option if the user is requested to enter valid credentials
during runtime using login dialog in a visualization.

o Do not perform a login on the device:

Select this option when using an old target device without user
management so that no login is required.

Update configuration:
Update while PLC is stopped:

If this option is enabled, the data source items are updated at the set
update interval, even if the control is stopped. Otherwise, updates are
not performed while the control is in "Stop" state.

Update rate (ms): Update interval for the variables in milliseconds.
Default: 200 ms.

Expert settings: If this option is enabled, the dialog is extended by the
following settings:

] Size of the communication buffer: Buffer size for communication
data in bytes.

Default: 50000.

e  Size of the monitoring buffer: Buffer size for the monitoring data in
bytes.

Default: 20000.
4.2.3 Adding a Data Server

A object can be added to an application with the
command.

Alternatively, a data server can be dragged into the Project Explorer from the
library (PLC objects). Only one data server can be set up per application and
the object cannot be renamed.

Add Dbject |
Add Object N
£ =5 3
Biame:
Finizh I LCancel
Fig.4-16: "Add Object” dialog, adding a data server

The necessary data server libraries in the global project library manager are
automatically added with the data server object and a data server task is cre-
ated in the task configuration of the application.
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Editors = The task priority has to be specified.

The command can be used to add one or multiple data
source objects to the application.

4.2.4 Adding a Data Source

A can be assigned to the of
an application using the command.

wr Project Explorer

= ) BRC_Control
() General module folder
= M BRC_MationCantiol_1
= 20 Logic
= OAunﬁcalion

'M::%m\ Add Object

UsetVaiGlobal

Libeay Managst Object -
=] FB1 PRl
E} MatonProg [PRG] E

— =] FiePiog (FRG]
B2 é Task Configuration Maitie:,
P D ataservesT as m
gk ATk Select Diata Saurce Type!

“em Profibus/M [Profibus DP Master) |standard pLC |
—#= Profingf_0_Controller (Profinet 101 g
_ 1 Motion = sl BRC Contral 1
3 'ﬁ Technalogy Application

&1

=] Robat 2 BRC_Control .2

SERCOS 1 £ Application

(4] Onboard_|0 {Onboard 1/0] ¥

% Inline_|3 (Inine 1/0] '

&= &l BRC_Control_1 I
=—E Loge rd

: f - LK

B

g DataServer
Library Manager
3] Pic_Mam(PRG] ]
& Symbal conliwalu,sf
i (8 Task Conliguratigh
& Datasen/erTas
& PlcTak
—— §) Orboxd |0 [Drboard )40
(1 Inine_ i inine 1/0) ¢
—Cmn Profibus/M [Prafibus DP Master)
= Puofinet_I0_Coribller Profinet 0 {

]
i
o8
Ig
L]

i Library Manager
=] Plc_Main (PRG)

i 8 Syrhol configuration

Fig.4-17: "Add Object” dialog, adding a data source

The "Add Object" menu provides a selection list (Select Data Source Type:)
to set the desired data source type.

Currently available "Default PLC":
#Ht In preparation ##t. OPC server.

The data sources that are currently available for the type set are then dis-
played in the window below the list. Select a data source and specify a sym-
bolic name.

After confirming with Finish, the data source object with the symbolic name is
added to the device tree below the data server for the application.

Example.

Data server and data sources

The Project Explorer currently contains three device entries: BRC_Motion-
Control_1, BRC_Control_1 and BRC_Control_2
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Editors
The application below BRC_MotionControl_1 would like to use data from the
BRC_Control_1 and BRC_Control_2 devices.

First, add DataServer to all of the desired applications for all three controls
( )-
Then go to the data server of the BRC_MotionControl_1 control.
Select the data sources that correspond to this data server (
).

Now both sources should have been added to the Project Explorer as shown
in the figure below and can be

E --------- = BRC_MaotionControl_1

EE .{l Logic
. Ehssss -o ﬁppllcatlﬂﬂ

-ataS ource_BRC_Control_1
atasource BRC Control_2

Efﬁ BRC_Control_2
E| ......... @1] Logic
- n Application

: DataServer
o Library b anager

Fig.4-18: Example of data server and data sources
4.2.5 Using Data Sources in Visualizations

All visualizations assigned to an application can use all
that are also assigned to the application.

for data exchange can be used
when configuring the properties of a visualization element.

They can be entered manually or using the input assistant or "Intellisense"
function.

For manual entry, the entire variable path has to be entered based on the fol-
lowing syntax:

<Device name TfTor the data source>.<Function block
name>.<Variable name>.
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Editors
= Bit accesses used in visualizations that are executed using a data
server connection, only run if they contain literal offsets (i.e. no
defined constants).
Example.
Using a data source variable in the properties of a visualization element
See the "Properties" dialog for a visualization element below. The variable
"iCount" from a defined data source is used as text variable. This data source
is the device "Device2" and the application "App1" located there along with
function block "prg1".
Properties
" Filter = ¥4 Sort by - %.I, Sort order -
Properky YWalue
IR Il ~iay LLIpA
= Text variables
Text Yariable Device?. Appl.prgl .iCount -
Toolkip Yariable
= Dwnamic bexts
TewvHizk
Fig.4-19: Example for using a data source variable in the properties of a visuali-
Zation element
I By default, the selected variables are always only updated in the
currently active visualization.
If a variable is also used in another function block in the applica-
tion, is has to be updated explicitly there using the corresponding
function of the data server interface. (In this case, please contact
your current software supplier).
4.3 Declaration Editor
4.3.1 Declaration Editor, General Information

The declaration editor is a text editor to declare variables.

Behavior and appearance are thus determined by the current text editor set-
tings in IndraWorks » Tools » Options > IndraLogic 2G > Text Editor dialog
and in IndraWorks » Tools » Customize » Commands *> Edit dialog. The de-
fault settings for colors, line numbers, tab widths, indents, etc. can be made
there.

, either
textual or tabular view appears or it can be switched between the views via
the buttons "Textual / Tabular" at the right margin of the editor window.
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Text declaration editor

Table editor

Editors

Usually, the declaration editor is used in connection with a programming lan-
guage editor, i.e. it appears in the upper section of the window that opens if
an nhiect is adited or disnlaved in offline or

The declaration header describes the POU type (e.g. PROGRAM, FUNC-
TION_ BLOCK, FUNCTION ...) and can be extended by POU global pragma
attributes.

In online mode, the declaration editor is structured as a

Variable declarations can also be made in a global variable list and in data
type objects (DUTSs), but which work with their own editors.

Also refer to the general information on the

PlcProg{DCC_Control_01: Logic: Application] ¥ X

! Jramg I LI :;_,

PROGREM PlcProg E.

= ViR E
£l

' B

7 al: ARRRY[O..4, 0..2] OF DINT := [1,2(01, 1,2(01, 1,2(01, L,z(00, 1,2(01]; z

5 warl AT %0B0 : INT: 5

=

bolunwy : BOOL;
10 EHD VAR

-
4 |

Fig.4-20: Text editor view
Behavior and appearance of the textual editor are determined by the current
and "Customize"
dialog. The default settings for colors, line numbers, tab widths, indents, etc.
can be made there.
The usual Windows functions are available and even those of the
function are supported if necessary.

Note that function block selection is possible by pressing <Alt> while select-
ing the desired section of text with the mouse.

]

PlcProg[DCC._Control_01: Logic: Application]

b4

e[| Pl |

PROGRAM PlcProg | g | |
[ 5cope. [ Home | Address | Batatype [_iritialzation | Comment | Attributes
B VAR al ARRAVIO, 40,21 OFDINT  [1,2(01, 20, 1,200, 1,200}, 1,203 attribute ‘dsplaymods’=tex warring 'This fs & warri
@ VAR varl woBD INT
# VAR boDummy BOOL

=

<

Fig.4-21: Tabular editor view

The tabular version of the editor displays columns for common definitions re-
: "Validity range® (visibility),

"Name*“ , "Address” , "Data type“ , "Initialization® , "Comment* and "Attrib-

utes”. The individual declarations are inserted as numbered lines.

The declaration header can be edited in the "Edit Declaration Header" that
opens with the command of the same name from the context menu.
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Editors

Edit Declaration Header i

- IF'II_'F'I ]

I e :

oeogram for bemp calculation _:j

Atkributes, ., | oK I Zancel |

Fig.4-22: "Edit Declaration Header” dialog

Type (from the selection list) and name of the POU object can be entered be-
low "Declaration“. A comment can be entered (line breaks with <CTRL> +
<Enter>). With the "Attributes® button, the "Attributes" dialog can be opened
to enter pragmas and attributes.

To insert a new declaration line above an existing one, select the existing line
and click on %" "Insert" from the toolbar or the context menu.

To add a new declaration at the very bottom of the table, click on the last ex-
isting line and use the "Insert" command as well.

The newly inserted declaration is provided with the validity range "VAR" and
the latest data type entered. The input field opens automatically for the obli-
gatory variable "Name*®. A valid identifier has to be entered there and then
closed either with <Enter> or by clicking to a different section of the view us-
ing the mouse.

Each table cell opens the respective input option with a double-click on the
cell. To enter the validity range, a drop-down list opens from which the de-
sired range and fitting attribute (flag) can be selected.

Enter the "data type" directly or click on ">* button to reach the
or the

Enter the "initialization value" directly or click on the array and use the dialog

of the same name especially useful for structured variables via J
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Editors
Initialization ¥alue
| Expression | Tnit walte: | batatype '
= al BRRAY [0..4, 0..2] OF DINT
-~ al[o,0] 1 DINT
at[g, 1] 0 DINT
al1[o, 2] il DINT
~alf1, o] 1 DINT
al[1,1] o DINT
—alf1,2] o DINT
-~ al[z,0] 1 DINT
al[z, 1] il DINT
—ai[z,2] a DINT
ai[3, 0] 1 DINT
al[3, 1] 0 DINT
-~ alf3,2] 0 DINT
al[4, 0] 1 DINT
al[4,1] ] DINT
ai[4, 2] o DINT
[ Apply vl to selected Ines | Reeset selected Ines bo defauk vaues |
f oK ' “Cancel r

Fig.4-23: "Initialization Value" dialog

All expressions of the variables are represented with their current initial val-
ues. Select the desired ones and edit the value in the field below the list.
Then apply it via the button "Apply value to selected lines". The default initiali-
zation can be restored via the button "Reset selected lines to default values".

Line breaks in the input fields of the comment column can be inserted with
<Ctrl> + <Enter>.

The Attributes enfries are made in the "Attributes” dialog in which multiple at-
tributes and pragma statements can be entered as text. They have to be en-
tered without {} and each in an individual line. The example shown in the fol-
lowing figure comresponds to the textual view that can be seen in the figure
"Textual editor view".

attribie ‘dispaymode = =Tex" d
wEmInG This S 8 warmeng
texd Part xy has been compied complstely]

_ =
o Canel |

Fig.4-24: "Altributes” dialog
Each variable is declared in an individual line. The lines are numbered.
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Editors

The order of the lines (line numbers) can be changed using the commands

* "Move up" or ¥ "Move down" (context menu or toolbar). The currently
selected line is moved down by one position.

The list of declarations can be sorted by a column by clicking on the respec-
tive column header. The column specified for the sorting is labeled with an ar-

row: (sorted in ascending order) or (sorted in descending order).
Each click in the column header switches between ascending and descend-
ing.

To delete one or multiple declarations, select the respective lines and click on
<Del> or use the "Delete" command from the context menu or toolbar}{.

4.3.2 Declaration Editor in Online Mode

After login into the target system, each project object that was already dis-
played in a window in offline mode is automatically displayed in the online
view.

The online view of the declaration editor displays a table like those used in

The header always contains the current object path:
<Device name>_<Application name>_<Object name>.

The table displays the data type and the current value for each expression

(watch expression), and - if it is currently set - the prepared value for
or

dialog.
Altematively, enter the value directly (after a click) in the respective field in
the "Prepared value" column.

Handling a Boolean variable is even easier: Use the Return key or Space bar
to toggle the prepared value according to the following sequence: If the pre-
pared value was TRUE, enter FALSE -> TRUE -> Space. Otherwise, if the
prepared value was FALSE, enter TRUE -> FALSE -> Space.

If a declaration function block follows a declaration (here an instance of a
function block), a plus or minus sign has to be precede. Click on this sign to
see the declaration function block.

Symbols indicate if the respective variable is an input *# output Fgs or "nor-
mal" % variable.
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Fig.4-25: Declaration editor in the upper section of a program object, online

Device Editor
Device Editor, General Information

The device editor provides dialogs to configure a managed
in the Project Explorer.

By default, the device dialog can be opened by double-clicking on the control
when it is selected in the Project Explorer.

The title of the main dialog is the device name (e.g. DCC_MotionControl1)
and, depending on the device type, it contains a combination of the follow
subdialogs:

Applications

view

. List of the applications on the control.
: Displays PLC log file.

The tab can be switched off and on via Options * IndraLogic 2G » Gen-
eral Settings » Enable PLC Logger.

: General information on the device (name, ven-
dor, version, etc.)

This tab is used to display and, if required, to delete applications that are cur-
rently located on the control.
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Fig.4-26: Device dialog, Applications

Applications on the PLC: List of the applications that were found on the con-

trol during the most recent "scan" (with "Refresh"). If a scan was not yet car-

ried out or is not possible because a gateway for a connection was not con-
figured, a message is output.

Refresh List: The control is searched for applications and the list is refreshed

accordingly.

Remove or Remove All: The currently selected applications or all applications

are deleted from the control.

If an application is loaded to the control, the following is checked first:

e The list of applications on the control is compared with those available in
the project. If the lists do not match, the corresponding dialogs appear,
either for loading the applications not already present on the control or
for deleting other applications on the control.

® The "externally implemented” function blocks in the application to be
loaded are checked to see if these are also available on the control. If
not, a corresponding message ("Unresolved reference(s)") is output in a
message box and in the message window.

®  The parameters (variables) of the function blocks in the application to be
loaded are compared with those in the function blocks of the same
name in the application already present on the control (signature check).
If they do not match, a corresponding message ("Invalid signature(s)") is
output in a message box and in the message window.

443 Log

This tab is used to display the control loghook, i.e. to display events recorded
on the target system.

The tab can be switched off and on via Options » IndraLogic 2G » General
Settings » Enable PLC Logger.

Displayed are:

e Events at system start and shuts down (loaded components with ver-
sion)

e  Application download and loading the boot project
e  Customer-specific entries

® |og entries from I/O drivers

® |og entries from the data server
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Fig.4-27: Device editor, Log

A logbook entry is displayed with the following information:

Severity (Scaling): There are four categories for the severity of the event:
Warning(s), error(s), exception(s), information. The display for each category
can be displayed or hidden by using the corresponding button in the bar
above the list. The respective number of log entries are displayed for the re-
spective category on the button.

1 warningis) | € 0 error(s) | E 0 exceptionds) | €% 190 information{s)

Fig.4-28: Severity of event
Time Stamp: Date and time, e.g. "12.01.07 09:48:00"

Description: Description of the event, e.g. Import function failed of <CmpFile-
Transfer>

Component: Name of the respective component.

Com Name (component name): Here, it can be searched for an individual
component in a selection list to display only logbook entries that are related
to it. The default setting is "All components".

Logger: The selection list contains the available recordings. The default set-
ting is "<Default Logger>" specified by the target system, currently the same
as "PlcLog" for the IndraLogic runtime system.

Not yet available: The log list is automatically updated.

Currently, the list has to be refreshed using the £ button.
The content of the list can be exported into an XML file. To do this, press the

i button to open the standard dialog for saving files. The file filter is set to

"xml files (*.xml)". The log list is stored in the selected directory with the file
name entered and the extension ".xlIs". If the "Offline logging" option is ena-
bled, even actions that are not related to the connection with the control are
recorded. However, at this time it can only be implemented in the safety ver-
sion of the programming system.

= Please see the information on the diagnostic possibilities in your
System Description!
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4.4.4 PLC Settings

This tab is used to specify how the control behaves in the "Stop" state.

Applications1 log  PLC 3ettinge'] Configuratian | Information |

Application for 10 handling: |.¥\npllr.allnn :J
FLE settings
IV Updata 10 whils in stap
Behaviour for outputs i Stop ]Set all cutputs to default :J |

[T Update all yaiables in &l devices

[ Bus eyola options
Bz cycle task MationT azk :_J

Fig.4-29: Device editor, PLC settings

Application for I/O handling:  If several applications are available for the device, they are listed here. The
default application, which is automatically created with a default project, is al-
ways entered first.

PLC settings:  Update 10 while in stop: If this option is enabled (default), the values for input
and output channels are updated if the PLC goes into the "Stop" state.

Output behavior in "Stop" state:  The selection list provides the following options for handling the values of the
output channel when the control goes into "Stop" state:

. Retain current values: The current values are retained.

e  Set all outputs to default: The default values from the /O mapping are
assigned.

e  Execute program: The handling of the output values can be controlled
using a program in the project. This program name can be entered and
it is then executed when the control goes into "Stop" state. The "..." but-
ton can be used to open the input assistance to facilitate the program
selection.

Bus cycle options:  Bus cycle task: The selection list provides all tasks defined in the task config-
uration of the active application (e.g. "Motion task", "PLC task", etc.).

= Check the data of the tasks of your application and then enter the
desired task!

Select a specific task to control the bus cycle or select the "Unspecified" set-
ting if the task with the shortest cycle time, i.e. the fastest task, is to be used
here.
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445 Floating Point Exceptions in the PLC program

Background information

Types of floating point exceptions

Dialog description

= This feature applies only for IndraLogic XLC/IndraMotion MLC for
12VRS or higher.

It is preset, that the floating point exceptions are blocked in the
PLC program. This ensures compatibility for existing user proj-
ects.

For the IndraMotion MTX and IndraMotion MLD, handling of float-
ing point exceptions in the PLC cannot be configured. The dialog
in the device editor is omitted

Exceptions can occur during floating point calculations.
Example: Division by Zero

For this purpose, the PLC provides a default handing. That means that the
PLC goes into STOP state and the floating point exception is displayed.

The user can select whether
e the PLC goes into "Stop" state (default reaction) or whether

° the PLC remains in the "Run" state and continues the calculation for the
PLC project when a floating point exception occurs.

If the handling of floating point exceptions is blocked and if an exception oc-
curs during a floating point calculation, the floating point processor (FPU) au-
tomatically uses a value allowing the calculation to continue in most of the ca-
ses.

Example:

At floating point calculations, a division by 0 results in an infinite value. This
does not always work out and depends on the calculation method in the user
program. Continuing the calculation can thus also cause an invalid reaction of
the user program.

For new PLC projects, The floating point exception handling
Q should be at least switched on in the engineering phase.

In the IEEE standard for floating point calculations, different types of floating
point exceptions are defined. These are supported by floating point process-
ors according to IEEE standard.

e  Overflow

e  Underflow

e  Divide by zero

® |[nvalid

® |nexact (precision)
e  Denormalized.

It is not reasonable to execute an exception handling via software for all float-
ing point exceptions. If "Inexact’ exists permanently and the FPU hardware
rounds according to a preset algorithm, no software handling can be selected
for the "Inexact” floating point exceptions.

The device dialog opens in the right window when double-clicking on the con-
trol in the PLC project. There is a new "Configuration® tab.
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Apploations | Log | PLC Settige  Coniguratian | Infomation |

Wite Poramaters |

Parameter | Type. [ Vae | DetsrVeue | Ut | Descrigion ||
= % Floating Point Setlings _ _
- # Behaviour on Exception Enumeration of BYTE no reaction na.reaction
@ Overlow Enumeration of BY' TE enabled anabled
@ Underilaw Enumeration ol BY'TE enabled enabled
@ Division by Zera Enumeration of BY'TE anabled srabled
P Irwalid Operation Enurnerstion of BYTE snabled enabled
W Denommalized Enumeration of By TE shabled eriabled
Fig.4-30: Device dialog, here IndraMotion MLC L65, "Configuration” tab

There are no floating point settings in the "Configuration" tab. The floating
point settings are divided into two components:

e  Behavior on Exception
e  Floating Point Exceptions

In the component "Behavior on Exception", there are the following selection
options:

° no reaction
° PLC in Stop, no reaction

No reaction: All exception conditions occurring at floating point calculations
are ignored.

The PLC program is still executed (PLC remains in Run).
The floating point exceptions set in the dialog are not relevant in this case.

PLC in STOP: If enabled exception conditions occur, the PLC is switched to
Stop.

Floating point exceptions set to the "enabled" state in the dialog are consid-
ered.

Parameter | Type | walue | DefautVelue | Unt | Descripon |
= @ Floating Poni Seifings
# Behaviow on Excephion Enumetation of BYTE o feaction
= ¥ Floatmg-Point Exceptions nio reachon
# Overfiow Erumeration of BYTE enabled
# Undelow Enumeration of BYTE enabled enabled
# Dnvision by Zero Enumeration of BYTE enabled enabled
s @ Invald Operation Enumeration of BYTE enabled enabled
“ @ Denomalized Enumeration of BYTE enabled enabled
Fig.4-31: Floating point settings, behavior on exception

The floating point exceptions displayed in the dialog are only relevant if "PLC
in Stop" is set as behavior.

In the presetting, all floating point exceptions are enabled. However, the use
can disable any floating point exceptions:

Paramater | Type | Vaive | Defautalue | Unt | Description |
= § FoaimgFonl Seitnn
#® Behavioes on Exceplion Erwmesation of BYTE o ieaction i Eachion
= ¥ FhangPont Excephors
# Dvefion Eoumestonof 8YTE  [ooabled =] enabled
# Urdetiow Erumesstion of BYTE enabled
# DrveonbyZem Erumesstonof BYTE B enabled
co i Irvald Operation Enumeration of BYTE ehabled ehabled
o Denormalized Enumeration of BYTE enabled enabled

Fig.4-32: Floating point settings, floating point exceptions, overflow
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4.4.6

Default behavior

Information

Editors

= The floating point exception "Inexact® is not displayed. It is always
disabled.

The reaction of the PLC when a floating point exception occurs is the same
as for the previous exceptions.

e The PLC goes into the "STOP" state and EXCEPTION.
® The cause of the exception is entered in the logger.
®  The program location causing the exception is displayed in the monitor.

e "STOP" and "EXCEPTION ERRORS" are displayed in the status of the
programming system.

Example.

Floating point exception "Division by 0, exception enabled

— ~
IF boTestExcFloatTrRUE | THEN 2l =
& rVarll ) k= vard” 1 ] ¢ t¥ard 0 : T
BD ¥ B

E

-

< 12|

I = —itn2 coi3 chz | ins ||| Frogiam loaded -EXCEPTION |

Fig.4-33: PLC in STOP, EXCEPTION ERROR, Display of the cause in the pro-
gram code
™ cifine-Logging:
|®y '*":h.r-_};a’z}] O o4 ‘df-] Es »‘-v;ma'r-l?.e:_n}IQ 155 Informationen) | <Alls Kompanaritens = | Logger: <5tandard Logget>
[ comete . | Komponert=
[ @ reated with O5-ID 0x65e0256, O5-Prio 0 SyaTask
! -] System Error: No MasterParentCt ToDivw53Io
1) T ZN0T01YF:0  Net¥loader_SetChanne: U1 CUmphletsLoader
i} 28.09,2010 00:19:35:0  Netxloader_SetBoard: 000 CmphetxLoader
[i] 28.09.2010 00:19:35:0  <rookt>Plc-Task FPPPereeseeessereeeesssreseiavs?eelavssv?s??en« TaskDestroy fal.. SysTask
o 27.09.2010 23:5%:54:0 Ak least one Indication or Confirmation was deleted due to Timeout, Ackivate cylcic...  CmpHilscherCIFX
E 27.09.2010 23:59:52:0 |*EXCEPTION"‘ FPL DivisionByZeorapplicationTask: | CmplecTask
] 27.09,2010 23:59:23:0  SERCOS II-10: System Error: Mo MasterParentCh IoDry5alo
[ AT AN AN ATE O Bk sedden Cekchammalo 0o Carmhiakil s waun
Fig.4-34. Logger message
Example.

Floating point exception "Division by 0, exception disabled

IF hoTestExcFloat{TRUE| THEH

r¥arll nfinity | := r¥arZl 1 ]/ r¥ari @ |

ERD_IF

Fig.4-35: Program code, status display at running program
If no exceptions are enabled (as now), the PLC program continues running.
The result of the calculation is this case is the value "Infinity*.

This tab in the Device dialog displays some general information taken from
the device description file on the device currently selected in the Project Ex-
plorer: Name, Vendor, Categories, Version, Ordering number, Description,
figure if available.
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Editors ppbeaions | oo | PLE satings | Conteumion Infamaian |
Gnarall
o
:l
~Image;
Fig.4-36: Device editor, Information

4.5 Data Type Editor

(DUT, data unit types) can be created in
the data type editor. It is text editor and thus the appearance and behavior of
the current settinas are snecified in the

The data type editor window opens if an existing DUT object is opened for
editing.

The editor already contains the predefinition of an
which can be modified into a simple structure definition or into a
definition of another data type, e.g. an enumeration.

élr.uci-zﬁi&;tf:t-uniml;m : Logié: 'Applfe:aiion]"':__ .
i TYPE s'tru-:t_z EXTENDS Structl :
= & sTRUCT
3 iVar: IMT:
4 b¥ar: BOOL:
5| EHD STRUCT
6| END TYPE
4 :
Fig.4-37: DUT ediitor window with structure
y Enum[DCC_Control_01: Logic: Applicaliun]] x
1 TYPE Enum: (green, hlue, yellow); -
z|  EHD TYPE
jc}
Fig.4-38: DUT editor window with enumeration type
= For an enumeration type, remove the lines "STRUCT" and
"END_STRUCT".

A setting for an automatic opening of the editors can be made by inserting a
data type using the main menu Tools » Options *» IndraLogic 2G » General
Settings.
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A description of the initialization of arrays is located in orin
the

A description of the initialization of structures is located under

A description of the initialization of enumerations is located under
subrange types.

A description of variable initialization using the desired expressions is located
under

4.6 FBD/LD/IL Editor
4.6.1 FBD/LD/IL Editor, Overview

There is a combined editor for the programming in the following languages:
FBD ( ), LD ( )
and IL ( )-

That means that a common set of commands and eiements is used and the
three programming languages can be internally converted from one to anoth-
er. The programmer can switch into one of the the other editor views (

) at any time, even in online mode.

However, note that a few special elements cannot be converted and can only
be displayed in the corresponding language. There are also constructs that
cannot be converted between IL and FBD without ambiguity. For this reason,
they are "normalized" when reconverted to FBD, i.e. they are reset. This ap-
plies to the: negation and explicit/implicit assignments for function block in-
puts and outputs.
Behavior, appearance and menus are defined in the

. See the special setting options there for displaying comments and ad-
dresses in the editor.

If required, the menu structure can be reconfigured in the dialog under
IndraWorks » Tools » Customize » Commands.

The editor opens in a split window if an object is to be edited in FBD/LD/IL.
The upper section contains the

The programming language for a new object is specified when the object is
created using the

4.6.2 Programming Languages in the FBD/LD/IL Editor
Function Block Diagram - FBD

The function block diagram is a graphically oriented programming language.
It works with a list of networks, where each network contains a structure that
displays a logical or arithmetic expression, a call of a function block, a jump
or a return instruction.
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Tl T2

Ton Ton
T2, 0—IN [l 3 -Cl W af -Blink
Thes—{PT  ETFETL  T#la—(IT  ETFETZ

Inst

UphndD own
TRUE—|Enable Falue X
100 Anpl itude Upf Up
Elink—|GoHome Lownf— Down
LENH SUB RIGHT COHCAT
arRotate STR j stRotate | 4TR STRL I =tRotate

1 S1EE STREZ
LEFT

stRotate—|3TR
1—5IZE

Fig.4-39: Example of a few FBD networks

The ladder diagram is a graphically oriented programming language, similar
in principle to an electrical circuit.

On one hand, the ladder diagram is suitable for constructing logical switches,
but on the other hand, networks as in FBD can also be created. For this rea-
son, LD is very suitable to control calls of other function blocks.

The ladder diagram consists of a series of networks. A network is limited on
the left and right sides by a left and a right vertical electrical power supply.
Between these is a circuit diagram made up of contacts, coils, optional func-
tion blocks (POUs) and connection lines.

On the left side, each network consists of a series of contacts transmitting the
states "ON" or "OFF" from left to right. These states correspond with the Boo-
lean values TRUE and FALSE. Each contact has a Boolean variable. If the
variable is TRUE, the status is transmitted across a connection line from left
to right. Otherwise, the right connection receives the value OFF.

Tl T2
T2.0 BEL ~ ToN | Blink
N be a b | a {7
TH2s—PT ETyETL ET§ET2
T#ls PT
Fig.4-40: Example of an LD network

The instruction list is a IEC61131-compliant programming language that is
similar to an assembler language.

It supports accumulator-based programming. All IEC 61131-3 operators are
supported as well as multiple inputs, multiple outputs, negations, comments,
setting/resetting outputs and conditional/unconditional jumps.

Each instruction is primarily based on loading the values to the accumulator
(LD instruction). Afterwards, the corresponding operation is executed using
the first parameter from the accumulator. The result of the operation is written
to the accumulator again from where the user should save it to using an ST
instruction.
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4.6.3

Editors

For programming conditional executions or loops, the instruction list supports
relational operators (EQ, GT, LT, GE, LE, NE) and jumps. Jumps can be un-
conditional (JMP) or conditional (JMPC / JMPCN). For conditional jumps, a
check is made to see if the value in the accumulator is TRUE or FALSE.

An instruction list (IL) consists of a series of instructions. Each instruction be-
gins on a new line and includes an operator and, depending on the type of
operation, one or multiple operands separated by commas.

An identifier (label) can be located in front of an instruction followed by a co-
lon (;). It identifies the instruction and can be used as a jump target for exam-
ple.

The last element in a line has to be a comment. Empty lines can be inserted
between instructions.

Empty lines can be located between instructions.

i jprosmw TL

Fa iR

3 instl: TOE:

53 devar: DIED:

5 de=Fes: DEORD :

B i TIME:

7 toucl: TINE;

= inscZ: TON:

F b¥ar: BiME.:

F BD VAR
i F i bVar vartable
ST instl. . TN starts tiwar with risin,
SFC =l
CRAL inscl{
Fr:=t1,
FT:=>toutl)
ip instl. iz THUE, PT seconds aft.
=T inscz. TN starts timer with srsiz.
ml
LIx du¥ar
ADD 230
sT duRes
Fig.4-41: Program example in the IL table editor

The IL editor is a table editor that is integrated into the

Modifiers and Operators in IL

In the language, the following operators and modifiers can be
used.
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Modifiers:

C |With JMP, CAL, RET

The instruction is only executed if the result of the preceding expression is TRUE.

With JMPC, CALC, RETC

The instruction is only executed if the result of the preceding expression is FALSE.

N |else Negation of the operand (not the accumulator)
Fig.4-42: Modifiers
The following table includes all IL operators with their possible modifiers and
meanings:
The"accumulator” always contains the preceding value of the previous opera-
tion.
Operator | Modifier Description Example
LD N Loads the (negated) value of the operand to the accumulator LD ivar
ST N Saves the (negated) contents of the accumulator to the operands STiErg
S Sets the operands (type BOOL) to TRUE if the accumulator content is TRUE S bVar1
R Sets the operands (type BOOL) to FALSE if the accumulator content is FALSE | R bVar1
AND N, ( Bit-by-bit AND of the accumulator value and the (negated) operand AND bVvar2
OR N, ( Bit-by-bit OR of the accumulator value and the (negated) operand OR xVar
i i i XOR N,
XOR N,( Bit-by-bit exclusive OR of the accumulator value and the (negated) operand
(bVar1,bVar2)
NOT Bit-by-bit negation of the accumulator value
ADD
ADD ( Addition of the accumulator value and the operands. Result in the accumulator | )
(iVar,iVar2)
SUB ( Subtraction of the operand of the accumulator value. Result in the accumulator | SUB iVar2
MUL ( Multiplication of the accumulator value and the operand. Result in the accumu- MUL iVar2
lator
DIV ( Division of the accumulator value by operands. Result in the accumulator DIV 44
Check whether the accumulator value is greater than the operand value. Result
GT ( : i GT 23
(BOOL) in the accumulator; >
Check whether the accumulator value is greater than or equal to the operand .
GE ( value. Result (BOOL) in the accumulator; >= GE ivar2
Check whether the accumulator value is equal to the operand value. Result .
EQ ( (BOOL) in the accumulator; = EQiVar2
Check whether the accumulator value is not equal to the operand value. Result .
NE ( : i NE iVar1
(BOOL) in the accumulator; <>
LE ( Check whether the accumulator value is less than or equal to the operand val- LE5
ue. Result (BOOL) in the accumulator; <=
Check whether the accumulator value is smaller than the operand value. Result
LT ( . ) LT cVartl |
(BOOL) in the accumulator; <
JMP CN Unconditional (conditional) jump to the specified label JMPN next
CAL CN (Conditional) call of a program or function block (if the accumulator value is CALC prog1
TRUE)
RET Exiting the function block and returning to the calling function block RET
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Editors
Operator | Modifier Description Example
RET c ConlelonaI - if the .accumullator value is TRUE - exiting the function block and RETC
returning to the calling function block
RET CN Condltlongl - if the accgmulator.value is FALSE - exiting of the function block RETCN
and returning to the calling function block
) Evaluation of the postponed operation

Fig.4-43: Operators and modifiers
® |nformation on

e Information on using multiple operands, complex operands, function,
method, function block, program, action calls and jumps; see

The following shows an example program with some modifiers:

1
AHD TRUE load TRUE to gccumulator
AHDH bVarl axaecute AND with negated vralue of bVari
JMEC ml if dccum. is TREUE, jump to label "ml'™
LDH bVar2 store negated value of B¥azri...
ST hResz ... in bRes

z mi:
LD b¥arz store value of bVari...
ST bRes ... iz bRes

Fig.4-44. Example of an IL program

46.4 Working in the FBD and LD Editors

Networks are the basic units of FBD and LD programming. Each network
contains a structure that displays a logical or arithmetic expression, a call of a
programming function block (function, function block, program, etc.), a jump
or a return instruction.

When a new object is created, the editor window already contains an empty
network.

= Behavior, appearance and menus are defined in the
. See the special setting options there for displaying
comments and addresses in the editor.

Tooltip with information on varia-  If the cursor is pointing to a variable or a function block parameter, its data
bles or function block parameters  type is shown in a tooltip.

If it is defined, the address and symbol comment are also shown as well as
the operand comment in double quotation marks in a second line.

Inserting and arranging elements: e  The most important commands for working in the editor are always loca-
ted in the context menu.

®  The programming units (program elements) are inserted either by using
the "Add" commands that are available by default in the
or by dragging and dropping the element from the
in the editor window. Inserting from the menu is based
on the current cursor position and the present selection (multiple selec-
tions are also possible). When inserting from the toolbox, the possible
insertion positions are displayed with position markers highlighted in
green when the mouse is dragged over the element in the editor window
and the element is inserted at this marker with a click.
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e The commands Cut, Copy, Insert and Delete available in the "Edit
menu" by default can be used to arrange the elements and networks.

® The possible insertion positions are described in the

e Inserting EN/ENO function blocks is handled differently in the FBD edi-
tor and in the LD editor. For more information, refer to

(Adding EN/ENO function blocks is not supported in the IL editor.)

The arrow keys can be used to jump between adjacent
within and across networks.

® The <Tab> key can be used to jump to the next within
the network.

e  <Ctrl>+<Pos1> focuses the start of the document and highlights the first
network.

e <Ctrl>+<End> focuses the end of the document and highlights the last
network.

e <PageUp> moves a page up and highlights the top rectangle.
e <PageDown> moves a page down and highlights the top rectangle.

e An element can be selected via mouse click or using the arrow or tab
keys to move to the corresponding cursor position.

e  Multiple non-adjacent elements can be selected by holding down the
<Ctrl> key while selecting the desired elements one after the other.

e  Multiple adjacent elements can be can be selected by holding down the
<Shift> key while selecting two contacts, one at the beginning and one
at the end of the desired network section. To cut (copy) a network sec-
tion and re-insert it, hold down the <Ctrl> key while selecting two con-
tacts that define the section. Then, the elements located between the
contacts are automatically included.

If a function block was added in the editor, open it with a double-click or using
the command "Search symbol - Go to definition" of the context menu.

Poligono Indutrial O Rebullén s/n. 36416 - Mos - Espafia - rodavigo@rodavigo.com



DOK-IWORKS-IL2GPRO*V12-AP01-EN-P Bosch Rexroth AG 345/697
Rexroth IndraWorks 12VRS Indralogic 2G PLC Programming System
Editors
) et | 4%
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= 2 v 3
3 S Yars for first netwoerk
4 Ti, T2: TON:
5 ET1, ETZ: _'m!::
5 Blink: BOOL: |
£ 53]
F B
POUToCall
HyCowunter —(Counter D own Cotat| MyDowmCounter
2 —jDecrement bErrorfErr
wErrorf-EriCode E
s
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1 —|4IZE
Loy
bial IResetkotion —C Cont.
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£ 2
Fig.4-45: Example of an FBD edifor window

TR T S O I )

":allTes_t-' @ UpAndDown |

[FUNCTION BLOCK UpindDowm IMPLEMEWTS HomingDevice
VIR THPUT

Enahle: BOOL;

dmplitude: IHT:

GoHome: BOOL:
END VAR

=2

GoHome

® Cont

.L
I

=
=

g
g

1
|

Cont:

4 RETURNM

&

&l

Fig.4-46:
For information on the programming language, see.

Example of an LD edifor window
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4.6.5 Working in the IL Editor

The IL ( ) editor is a table editor in contrast to the pure text editor
used in IndraLogic 1.x. The network structure of FBD or LD programs can al-
is suffi-

cient, although when considering switching back and forth among the FBD,
LD and IL views of a program, it might be advantageous to purposely struc-
ture an IL program using networks.

== Behavior, appearance and menus are defined in the
. See the special setting options there for displaying
comments and addresses in the editor.

Tooltip with information on varia- I the cursor is pointing to a variable or a function block parameter, its data
bles or function block parameters type is shown in a tooltip.

If it is defined, the address and symbol comment are also shown as well as
the operand comment in double quotation marks in a second line.

Inserting and arranging elements: e  The most important commands for working in the editor are available in
the context menu.

®  Programming units, i.e. elements, are inserted at the current cursor po-
sition using the "Add" commands located in the
by default.

e  The commands Cut, Copy, Insert and Delete available by default in the
"Edit menu", can be used to arrange the elements.

®  The possible cursor positions are described in

Information on the IL programming language can be found in

The following shows how the IL table editor is structured, how the table is na-
vigated and how complex operands, calls and jumps are used.

Structure of the IL table editor.  Each program line is in one table line divided into individual fields by the fol-
lowing table columns:

Column Contains... Description

This field contains the IL operator (LD, ST, CAL, AND, OR, etc.) or a function hame.

If a function block is called, the corresponding parameters have to be entered here as well.

Operator In this case, ":=" or "=>"has to be entered in the prefix field.
1
This field contains ":=" or "=>" if the parameter for a function block call is in the operator
Prefix field
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Column Contains... Description
This field contains exactly one operand or the name of a jump label. If more than one oper-
"AND A, B, C" or function calls with multiple parame-
Operand ters), they have to be entered in the following lines in which the operator field is empty. In
this case, enter a comma in the posffix field to separate the parameters from each other
5 (see the following figure, "IL table editor").
per operator or in case of function calls, this field contains the
Postf separating comma or the opening or closing parenthesis.
ostfix
If a or is called, the corresponding opening and closing pa-
rentheses have to be added.
This field contains the address of the operand as it was defined in its declaration. The field
3 Address cannot be edited and can be shown or hidden in the view using the
Symbol This field contains the comment that might have been entered for the operand in it declara-
4 tion. The field cannot be edited and can be shown or hidden in the view using the
comment
0 d This field contains the comment for the current program line. This can be edited here. The
peran . . .
5 display of the comment can be shown or hidden using the
comment

Fig.4-47: IL fable editor

PROGRAM myFuncCall

Star
é!_- tonInstl (
IN: = bV¥ar,
PT:=£1;
ET=> tOucl)
I tonInstl.
ST tonInst2. IN
CAL tonInstZ|(
PT:=t2
0=> bReady, B for toxnlmsts
ET=> thucZ)
1] 2] 3] 4] [&]
For explanations on the columns 1...5, see table "IL table editor"
above
Fig.4-48: IL table editor

Navigating in the teble: e  <Up> and <Down> arrow keys: Jump to the field above or below
e  <Tab>: Jump to the next field within the line (to the right)
e  <Shift> <+> <Tab>: Jump to the previous field within the line (to the left)

e <Space bar>: Opens the editing frame for the currently selected field.
Alternatively, click on the field. If necessary, the input assistance dialog

can be accessed with the E] button. An open input field can be exited
with <Enter> or <Esc> which discards the new entries.
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e  <Ctrl> <+> <Enter>: Inserts a new line below the current line
e  <Del>: Deletes the line in which the cursor is currently positioned.

e  Cut, copy, paste: To copy one or multiple lines, select at least one field
in the line(s) and use the "Copy" command. To cut a line, use the "Cut"
command. "Paste" adds the previously copied or cut line(s) above the
current line. If the cursor is not currently positioned in any line, it is pas-
ted at the end of the network.

e <Ctrl>+<Pos1> focuses the start of the document and highlights the first
network.

e <Ctrl>+<End> focuses the end of the document and highlights the last
network.

e <PageUp> moves a page up and highlights the top rectangle.
e <PageDown> moves a page down and highlights the top rectangle.

Multiple operands (extendable op-  |If the same is used with multiple operands, there are two program-
erators).  mjng options:

1. The operands are entered in successive lines separated by commas in the
postfix field. Example:

4
LD 7
ADD 2,
4,
=
5T ivVar
Fig.4-49: Multiple operands (extendable operafors), e.g. 1

2. The instruction is repeated in successive lines. Example:

3

LD 7
ADD 2
ADD 4
ADD 7
ST 1VAR
Flig.4-50: Multiple operands (extendable operators), e.g. 2

Complex operands:  If a complex operand is used, an open parenthesis has to be entered in the
prefix field, the further operand entries in the following lines and the closing
parenthesis in a separate line, also in the prefix field.

Example: A string is rotated; each cycle by one character
Code in Structured Text:
stRotate := CONCAT(RIGHT(stRotate, (LEN(stRotate) - 1)), (LEFT(stRotate, 1)));

Code in IL:
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4 LD atForate

RIGHT ( stFotate

LEH

SUB 1

}

COHCAT ( stRotate

LEFT 1

)

5T stRotate

Fig.4-51: Complex operands

Function calls:  The function name is entered in the operator field. The input parameters have
to be used as operands in a preceding LD operation. The return value of the
function is written in the accumulator, but...

Note the following limitation with regard to the IEC standard: A function call
with multiple return values is not possible. Only one single return value can
be used for the following operation.

Example:

Function X7 is called. "25" is transferred as a input parameter and the return
value is assigned to the variable "Ave":

Code in Structured Text:

Ave := GeomAverage(X7, 25);

Codein IL;
LD 7
GeomfAvrerage 25
5T hve
Function block calls, program here. Enter the name of the function block in-

calls:  stance and the program name in the operand field. The opening parenthesis
is entered in the same line in the postfix field. The input parameters are en-
tered individually in the following lines as follows:

Operator field: Parameter name
Prefix field: ,:=" for input parameters; "=>" for output parameters
Operand field: Current parameter

Postfix field: "," if more parameters are to be entered; ")" after the last param-
eter

If there are calls without parameters, the postfix field has to contain "()".

Example: Call of POUToCAIl with two input and two output parameters
Code in Structured Text:

POUToCall (Counter := MyCounter, Decrement:=2, bError=>Err, wError=>ErrCode);

Code in IL:
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PROGERM IL_EXAMPLE
VAR
bEzr: BodL:
uRezult: WOED:
EHD VAR

CAL POUToCall (
iCounter:= 1,
iDecrement:= 1000,

wError=> wResult)

LD POUToCall.bEcrox
5T bErr
Fig.4-52: Example for a program call in IL with input/output parameters

Not all parameters of a function block or program have to be configured.

= Based on limitations of the IEC standard, complex expressions
cannot be used. They have to be assigned to the function block or
the program before the call.

Actioncall:  Execution as with a function block or program call. The action name has to
be added to the instance name or program name.

Example: Call of the action "ResetAction"”

Code in Structured Text:

Inst.ResetAction();

Code in IL:

CAL Inst.Eesetdction()

Method call:  Execution as with a function call:

The instance name with the attached method name has to be entered in the
operator field.

Example: Call of the "Home" method
Code in Structured Text:

Z := IHome.Home(TRUE, TRUE, TRUE);
Code in IL:
LD TERUE
THome . Home TRUE,
TRUE
5T Z
Jump: is programmed by using "JMP" in the operator field and a jump label

name in the operand field. The jump label has to be defined in the target net-

field. Note that the instruction sequence preceding the un-
conditional jump has to end with the following command: ST, STN, S, R,
CAL, RET or another JMP. This does not apply for a conditional jump pro-

Poligono Indutrial O Rebullén s/n. 36416 - Mos - Espafia - rodavigo@rodavigo.com



ROBAVIGS, S.A.

RODAMIENTOS VIGO, S.A.

www.rodavigo.net +34 986 288118

Servicio de Att. al Cliente

DOK-IWORKS-IL2GPRO*V12-AP01-EN-P Bosch Rexroth AG 351/697
Rexroth IndraWorks 12VRS Indralogic 2G PLC Programming System

4.6.6

Editors

grammed with the command "JMPC" in the operator field instead of "JMP".
The execution of the jump depends on the loaded value.

Example: Jump instruction: if bCal IRestAction is "TRUE", the program
execution jumps to the network with the "Cont" label.

Code in IL:
LDH bCallRezetiction
JMPC Cont

Cursor Positions in FBD, LD and IL

Possible cursor positions:

IL editor:

This is a text editor structured as a table. Each table cell is a possible cursor
position. See also:

FBD and LD editor:

These are graphical editors. See below: examples (1) to (15) show the possi-
ble cursor positions: Text, input, output, contact, coil, return jumps, connec-
tion line between elements and networks.

Setting the cursor corresponds with "selecting” an element or text. Actions
such as cutting, copying, pasting, deleting and other editor-specific com-
mands can be used at the current cursor position or at the currently selected
element.

Also refer to
[ ]

In FBD, the current cursor position is displayed with a dashed frame around
the respective element. In addition, texts and function blocks as well as coils
and contacts are displayed with a blue or red background.

In LD, coil and contact symbols appear in red when the cursor is positioned
there.

The cursor position determines which element is provided in the context
menu for the

(1) Each text field:

In the following figure, the possible cursor positions are displayed at left with
ared frame. At right, a function block is shown in which the cursor is currently
positioned in the "AND" field.

Note that instead of the variable name, the addresses can also be displayed
if the corresponding option is enabled in the

{RADD
(33—

(2) Each input:

ADD
ivar— ——erdg
33

(3) Each operator, function or function block:
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ivar— g ery
33— :

(4) Each output followed by an assignment or a jump:

ADD
iwar—] f—erg
33

(5) The position in front of a branch to an assignment, a jump or a return in-
struction:

ADD ADD
ivar— :|_ —erg
33 ergs  ivars—]

(6) The cursor position located farthest to the right or anywhere in the net-
work where there are no other cursor positioned. This selects the entire net-

work:
""""""""" # Evrdluation endswitches
eral. swil
XOR
TRUE — —— varoutput
E
-

(7) The line cross directly in front of an assignment:

ADD

e b

Her g2

(8) Each contact

awitchl

—

(9) Each call
lampl

—]
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(10) Each return and jump:

LA TR ) E T

(11) The connection line between contacts and coils.

brrar rE-E)

1 [ : ]
by

(12) Line branch or "subnetworks" within a network

ADD L1133

iva}lj:: + % | 21

21

aa — =
bb —

Fig.4-53: Line branches

(13) Connection line between parallel contacts (pos. 1-4)

wvarl wvars
Il 1 [
1 VArd varl 3
8 I
2 vard 4
{ [
Fig.4-54. Connection line between parallel contacts

(14) In front and behind networks

-1
[
s
[Ss 777 e
Fig.4-55: In front and behind networks

New networks can be added at the left side of the editor. Inserting a new net-
work in front of an existing network is only possible in front of network 1.

(15) Beginning or end of a network
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T2 wasl b
I {1 4 {7
warl rar3
I I I
LR ] LU ]

Fig.4-56. Beginning or end of a hetwork

Contacts and function blocks can be inserted at the beginning of a network
on the "Start here" field. The elements return, jumps and outputs can be in-
serted at the end of a network on "Add output or jump here" field.

4.6.7 FBD/LD/IL Menu

, the FBD/LD/IL menu is availa-
ble in the menu bar by default. The menu provides the following commands
for programming in the editor:

:

[
Toggle nebwatk comment state
Trsart Jurmp
Insert Bebom
Tnsert Trput

Trssert Contact (right}

Insert Contact Paralled (balow)
Insert Contact Parallel {above)
Insert contacts. ¥ pastebelon
Negstion Paste right {after)
Edge Detection | Paste chove

| SetjResst

. Insert Branch

ﬁ’* ? I?i Wigw as Finction black diagranm

»oawe £ 8+ R LR

b

Wiews as ladder logic

Wigw as instruction list

Fig.4-57: FBD/LD/IL menu, here subset of the ladder diagram

A description of the individual commands can be found under

If required, the menu structure can be reconfigured in the dialog under
IndraWorks » Tools » Customize » Commands.
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4.6.8 FBD/LD/IL Elements Editors

FBD/LD/IL tools provides a toolbox in a separate view from which the
individual programming elements can be inserted into the editor window via
drag&drop. By default, the toolbox is opened automatically next to the editor
window, but if necessary, it can also be opened explicitly using the

command in the "View" menu.

Depending on which editor view is currently open, select the corresponding
elements in the toolbox. Elements that are not available are shaded in gray
(see the description for the respective ).

The "tools" (elements) are sorted in categories: General (general elements
such as network, assignment, etc.), logical operators, mathematical opera-
tors, function blocks (e.g. R_TRIG, F_TRIG, RS, SR, TON, TOFF, CAD,
CDU), ladder diagram elements and POUs.

The "POUs" category provides all POUs created by the user below the same
application as the FBD/LD/IL function block opened in the editor. If a bitmap
is assigned to a POU in "Properties", it appears in front of the POU name.
Otherwise, the standard icon appears to label the POU type. The list is auto-
matically updated if POUs are added or removed below the application.

Open the category, i.e. display the elements, by clicking on the button with
the category name. See the following figure: "General" category is expanded
and the others are collapsed. The figure shows an example for inserting an
assignment from the toolbox via drag&drop:

] POU_FBD | |§] PLC_PRG 1 b X
L PROGRAM POU_FED A lGeneral
" VIR B Networl
Reser Fool: BOOL;
PV Int: INT: (= pw

=it ASSignment

=+ Jum
0 Bool: BOOL; - e
8 CV Imt: INT; | e Rebam
< > o Input

HOT e Bodlean Operaiors
22y — y—’{ﬁ??? ,_ Math opsrators
=, : Ladder elements

Fig.4-58: Example of inserting from the foolbox

To insert an element in the editor, click on it in the toolbox to select it and
hold down the mouse button while dragging it into the editor window. The
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possible insertion positions are indicated by position labels (usually dia-

monds) while dragging the element across the editor window with the mouse
button pressed. The closest possible insertion position lights up in green.
When releasing the mouse button, the element is inserted at the position dis-
played in green.

If a function block element is inserted at a position where another element is
already located, the new element replaces the old one. In principle, the inputs
and outputs already assigned to the old element are maintained.

Network in FBD/LD/IL

'y ‘ [T ' . . -

program.

In the FBD/LD/IL editor, the networks are arranged in a top-down list. Each
network has a consecutive network number at the left side and contains logi-
cal or arithmetic expressions, program, function or function block calls and a
jump or return instruction.

editor also uses the network element based on the common editor en-
vironment with the FBD and LD editor. If a POU is originally programmed in
FBD or LD and is then converted to IL, the network structure is maintained. If
a program is originally created in IL, it consists of at least one network that
can contain all instructions. However, in consideration of a planned conver-
sion to FBD or LD, it might be advantageous to structure the IL program us-
ing several networks.

A network can optionally be provided with a title, a comment or a that
can be used as a jump target for a jump from another network.

The availability of titte and comment fields can be switch on or off in the

If this function is switched on, the input field for the title can be opened by
clicking in the network directly below the upper limit. Click directly below the
title to open a text field to enter a comment. The comment can contain multi-
ple lines. Line breaks can be inserted with <Enter>. End the comment text in-
put with <Ctri>+<Enter>. Whether and how the network comment is dis-
played in the editor, is defined in the same "Options" dialog.

To insert a label that can be used as a jump target for a jump from another

command. After a jump label is
defined, it is displayed below the title or comment field, or, if these fields are
not present, directly below the upper limit of the network.

1 Network title
Nelwork comment
Label:
DD

] —

27
Fig.4-59: Position of title, comment and jump label in a nefwork
A network can be commented out, i.e. the entire network can be redefined as
a comment (' ") and therefore excluded from pro-
cessing.
When a network is selected ( ) the default commands for

copy, cut, paste and delete can be used.
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Assignment in FBD/LD/IL

Jump in FBD/LD/IL

Label in FBD/LD/IL

Editors

= If you right-click on a title, comment or label (cursor position 6),
only that item is selected, not the entire network. In this case, us-
ing the "default commands" does not affect the network itself.

See the description for adding a network in
Consider the option of " in a network"

RET Network:

In online mode, an additional empty network is automatically represented be-
low the existing networks. Instead of a network number, it is labeled with
"RET".

It represents the position at which it is returned to the calling function block
during processing and provides a possible breakpoint position.

In FBD or LD, an assignment is inserted as a line depending on the current
either directly in front of the input (cursor position

2), directly behind an output (cursor position 4) or at the end of the network

(cursor position 6). In an LD network, an assignment is inserted as a

After the insertion is complete, the character string "???" can be replaced by
the name of the variable that is to be assigned. The input assistance can be

accessed with the [:' button.

In , an assignment is programmed using the "LD" and "ST" in-
structions.

See also the

In or ,ajump is inserted as a line depending on the current

either directly in front of an input (cursor position 2), di-
rectly behind an output (cursor position 4) or at the end of the network (cursor
position 6).

After the insertion is complete, the character string "???" can be replaced by
the name of the label that is to be used as the jump target, i.e. the network, to
which the jump is to be made.

In , ajump is programmed using a "JMP" instruction.
See also the

network has a text input field below the field for the network

can be defined. This label is an optional identifier

for the network and can be entered as an address for a . It can consist of
any character string.

Poligono Indutrial O Rebullén s/n. 36416 - Mos - Espafia - rodavigo@rodavigo.com



RODAVISS, 8.A. www.rodavigo.net +34 986 238118

Servicio de Att. al Cliente

RODAMIENTOS VIGO, S.A.

358/697 Bosch Rexroth AG DOK-IWORKS-IL2GPRO*V12-AP01-EN-P
Rexroth IndraWorks 12VRS IndralLogic 2G PLC Programming System

Editors
1 Network title
Network comment
Label:
DI
27 —
rez
Fig.4-60: Label for nefwork

Function Block Call in FBD/LD/IL

network is a complex
element and can represent additional functions such as a timer, counter,
arithmetic operations or programs, IEC functions and IEC function blocks.

Such a function block can have any desired inputs and outputs and can ori-
gin either from a library or directly from a project. However, at least one input
and one output has to provide Boolean values.

Usage in FBD and LD A function block call can be inserted in the left section of an LD network (as a
coil) or in an FBD network using the "Add FB call" or "Add empty block" com-
mands or (for standard blocks) from the

UsageinlL Inan program, a instruction with parameters is inserted to call a func-
tion block.

You can get an update of the block parameters (inputs, outputs) in current
code - in case the function block interfaces have changed - by using the com-
mand ; the function block does not need to be
inserted again.

RETURN Instruction in FBD/LD/IL

Use a RETURN instruction to exit an , or function block.

In a FBD or LD network, the RETURN instruction can be placed parallely with
or subsequent to the preceding elements. As soon as the input of the RE-
TURN instruction is TRUE, the function block processing is interrupted imme-
diately.

For inserting elements, please see

in FBC: in LC:
RETURNM
—A RETURIM
—
Fig.4-61. RETURN element
In ,the is used for the same purpose.
Line Branching/Post-Interconnection in FBD/LD/IL
FBD and LD network, a line branch or post-interconnection splits a pro-

cessing line starting from the current cursor position. It is carried out in two
arms (subnetworks), from top to bottom one after another. Each subnetwork
can be branched more. Thus, multiple branching is possible within one net-
work.

Poligono Indutrial O Rebullén s/n. 36416 - Mos - Espafia - rodavigo@rodavigo.com



DOK-IWORKS-IL2GPRO*V12-AP01-EN-P Bosch Rexroth AG 359/697
Rexroth IndraWorks 12VRS Indralogic 2G PLC Programming System

Editors
Each subnetwork receives a label icon (rectangle) that can be selected (
) to execute actions on the subnetwork such as cut-
ting and pasting.

Lo aR
ivar — bvar
A 21
AHD
het_ a
TRUE — & l
resl
H—o»
. R
1] — 21
o 21
Fig.4-62: Examples for labeling nefworks within a nefwork.
The "Insert branch" command is used to add a branch to the FBD. Alterna-
tively, the element can also be obtained from the . Possi-
ble insertion positions can be found under
= Cut/Copy&Paste are currently not possible for subnetworks.

See the example in the following figure: A branch was inserted at the output
of the SUB function block. This creates two subnetworks. Each can be selec-
ted at a subnet label. Then, an ADD function block was added to each sub-

network
Sup
1var — = -
—
suB
ivar.— _ :
- - P
SuB: REDI
iwar —f - —
a — = &= +
s
|.: i + ¢
Fig.4-63: Example in FBD, Inserting a branch

To delete a subnetwork, all its elements have to be deleted first. That are all
elements on the right from the subnet label. The label can then be selected
and deleted with "Delete" or <Del>. Refer to the following figure: The three-
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Editors input OR element has to be deleted before the label of the lower subnetwork

can be selected and deleted.

[ amp | [ or
ivar 4 - b
i o+ — 21
] T~
Fig.4-64: Deleting branch or subnetwork

Execution in online mode:

The individual subnetworks in online mode are processed from left to right
and from top to bottom.

IL (instruction list)

In IL, line branching and post-interconnection are returned by a respective
sequence of instructions. See also the description of

Contact in FBD/LD/IL

This is a pure LD element.

contains one or multiple contacts in its left section. A
contact is displayed as follows:

bwarl

—

A contact transfers the condition "ON" (TRUE) or "OFF" (FALSE) from left to
right until it finally reaches a coil in the right section of the network. For this
purpose, a Boolean variable that contains the condition is assigned to the
contact.

Several contacts can be arranged in a sequence or in parallel. If there are
two parallel contacts, only one has to have the value TRUE for "ON" to be
transferred to the right. If contacts are connected in series, all contacts have
to contain the value TRUE for the "ON" to be transferred to the right from the
last contact.

This way, LD can be used to program an electric circuit in parallel or in ser-
ies.

A contact can also be . This is indicated by a slash in the
contact icon.

bwarl

—=

A negated contact only transfers the incoming condition (TRUE or FALSE) if
the Boolean variable assigned to it has the value FALSE. The
directly provides negated contact elements,

A contact element can be inserted into an LD network either by using the
commands
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FBD, IL

Coil

FBD/IL:

Set/Reset in FUP/KOP/AWL

FBD and LD

Editors

or directly via drag&drop from the

editor view, the commands for in-
serting contacts are not available. However, contacts that were previously in-
serted in the LD view are displayed using the corresponding FBD elements or
IL instructions.

This is a pure LD element.

Any desired number of coil elements can be inserted on the right side of a LD
network. A coil is displayed as follows:

bwarz

—]

Several coils can only be arranged in parallel. A coil transfers the value deliv-
ered from the left to the right and copies it into its assigned Boolean variable.
Its input value can be "ON" (TRUE) or "OFF" (FALSE).

A coil can also be negated indicated by a slash in the icon:

bwarz

—D

of the incoming signal is cop-
ied to the Boolean variable assigned to the coil. Therefore, a negated coil will
only transfer an "ON" signal if this variable has the value FALSE.

command loca-
ted in the FBD/LD/IL menu by default or via drag&drop from the toolbox, the
"Ladder diagram elements" category. 4 &

See also

editor view, the commands for in-
serting contacts are not available. However, contacts that were previously in-
serted in the LD view are displayed using the corresponding FBD elements or
IL instructions.

can be set or reset.
The output or the coil icon are identified with an S (set) or R (reset).

See also

Set: If the value TRUE is provided to a set output or a set coil, the output and
coil become TRUE and remain TRUE. The value can no longer be overwrit-
ten as long as the application is running.

Reset: If the value TRUE is provided to a reset output or a reset coil, output
and coil become FALSE and remain FALSE. The value can no longer be
overwritten as long as the application is running.
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Editors
AHD
byarl—j }:uv arl
bvar 2—]
Fig.4-65: Example of a sef output in FBD

In the LD editor, set and reset coils can be inserted directly via drag&drop
from the toolbox from the "Ladder diagram elements" category. -,

bhvarz bwarz
—fs) —R]
Fig.4-66. Examples of a sef coil and resef coil
See for information on set and reset coils.
IL  In an instruction list, the operators and are used to set or reset an oper-

and.

Set/Reset Coils

Coils can also be defined as set or reset coils. A set coil is identified by an
"S" in the coil icon: (S). A set coil never overwrites the value TRUE of the re-
lated Boolean variable, i.e. a variable with the truth value TRUE retains this
value.

A reset coil is identified by an "R" in the coil icon: (R). A reset coil never over-
writes the value FALSE of the related Boolean variable, i.e. if this variable
has the truth value FALSE, this value remains FALSE.

In the LD editor, use the mouse to drag set and reset coils directly from the
toolbox ("Ladder diagram elements": 4=+, ) into the editor.

bvarz bvarz
—fs) D
Fig.4-67: Example - Set coil, resef coil

4.6.9 FBD/LD/IL Editor in Online Mode

In the online mode of the FBD/LD/IL editor, there are views for
and for and variables and expressions
on the control.

(breakpoint, step-by-step execution, etc.) is
also available.
Monitoring ), itis available
in the FBD and LD editor views as small monitoring windows after each varia-
ble or in a separate column in the IL table editor.

These windows display the respectively current value on the target system
(Inline monitoring).

That also applies to function block inputs and outputs that are not assigned.

The Inline monitoring variable of a window displays a small red triangle in the
upper left corner if the variable is currently ,

MyCounter [ 40 =
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Editors

a blue triangle in the left bottom corner if the variable is currently forced and
prepared to cancel forcing:

SP_lor_ Win32.App.CallTest
Aursidriicl Kommeritar Datarityp Wit Worbetaiteter Wert
= Inatz Upandbown
“p Enable BOOL
A Amplicuds mr
*p GoHome (BOOL
i \l'éiue. T
"% Up BOOL
Fip Down BOOL
W Counter DINT
o divale DINT
g Ba0L
[ s INT
P2 T
#in o
# Down ‘BOOL
% MyCounter Wats for Hhird rietwork DC[NT - <lnforce and restares.
# MyDownCounter: DINT
@ Em Bool
@ ErrCode SWORD o
i stRoktate “ars for fifth netwerk.  STRING o [abe”
@ hive vars for fifth network  DINT 35
& In=td
TRITF siFriah 1 Walur—
200 —pwplivuds  Upe ENEE
FALSE ===iGoHome: Do =
4
PONToCall
Mycounter [ 4n  F=counter Dot Count———————————— MyD ownCount ex
2 —Deczaugnc vEezerf-ree R
wlreorf-ErrCode
stRotate. stRotate [ peaw'  |—3TR —
= | STZE
Fig.4-68: Online view of an FBD program
& War
¥ iRes
¥ iTemp
1
1 PLC_PRG.1X s
DD 22 agdd 22
ST iTenp 11488 store to temp
) PLC_PRG.1X
D 1
5T iVar 11467
CHL FREL( call prograpm DPRG
iIn:= i¥ar, 11467
ilut=> iRes) [ 114e8 |store ifut to iRes
Fig.4-69: Example: Online view of an IL program

In the online view of a ladder diagram (LD), the connection lines are colored:
Connections with the value TRUE are displayed with a bold blue line, con-
nections with the value FALSE as bold black line, and in contrast, connec-
tions with unknown or analog values are displayed as normal (thin black line).
(Note: the value of the connections is calculated from the value of the varia-
bles. This is not an actual sequence check.)
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Editors | & ace1 (W mcree R Acer G DEsl | R
Device.Application.DES1
‘Expression Typs Yalue Prepared valus - o~
= #Tee Ton =
*Te7 TOF
¥ TS50 TON
T TSt TOM
* pT=2 TOM
* #153 TN ¥
13] 2
TEMPLATE CEAIN CONV-[—"|
$DHE4S0 $INIE3.6 EIXI4E. 1 §IXIAE.L MEFO. L
IPl430 IP1436 IP1451 IP1451 nsol
—{u Ll [ fiE {0
AMXEO. 1 HIXIE2.T
M501 IP1437
G
1 B
<) >
Fig.4-70: Example - Online view of an LD program

A function block can be opened via double-click or by using the command
"Search symbol - Go to definition" of the context menu.

Forcing variables  In addition to be able to enter a prepared value for a variable in the declara-
tion section in each editor, you can also click on a variable in the implementa-
tion section, which opens a dialog in which the prepared value can be en-
tered in the FBD/LDV/IL editor in online mode

d Prepare Yalue [ X

Expression:  [MobionProg.ivar
Type: Fbﬁ‘

Current vahs: [51415

What do you wank b0 do?

% Prepare a niew valus For the nest wiike or Farcs cperation:

£ Remove preparation with & value,

= Release the farce, withouk modifving the value,

Release the Farce and restare the wariable to the walue it Had
before Forcing it

(0] 4 Zancel

Fig.4-71: Dialog - Prepare Value

The complete path for the variable in the device tree is shown along with its
type and current value. By enabling the corresponding item, decide whether
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Breakpoint or breakpoint positions:
(not yet available for the IL editor)

Editors

e a new value should be prepared that has to be entered into the editing
field

®  a prepared value should be removed
e a currently forced variable should be released

e a currently forced variable should be released and its original value re-
stored before it is forced

The selected action is carried out when the "Force value" command (Debug
menu item) is called or when <F7> is pressed.

Possible positions that can be selected for a breakpoint (

) for debugging purposes are always the positions where variable values
can change (instructions), where a program branches or where another func-
tion block is called. That are the following positions:

e  On the complete network. That causes the breakpoint to be set at the
first possible position in the network

e  On a function block (box) if the function block contains an assignment.
That is thus not possible for operators such as ADD, DIV). Refer to the
following note:

I A breakpoint can currently not be set on the first function block in
the triangle. If the breakpoint is set on the complete network, this
breakpoint position label is automatically transferred in online
mode to the first function block.

e  On assignments

e At the end of the function block at the return position to the calling func-
tion block. In online mode, an empty network automatically appears at
this place which is labeled with "RET" instead of a network number.

The currently possible positions can be seen in the selection list in the

. A network containing an active breakpoint is
labeled with the breakpoint icon (red filled circle) on the right next to the net-
work number and with a red-shaded rectangle by storing the first breakpoint
position possible in the network. Disabled breakpoint positions are displayed
by an empty, red circle or a red rectangular frame.

Poligono Indutrial O Rebullén s/n. 36416 - Mos - Espafia - rodavigo@rodavigo.com



366/697

Editors

Bosch Rexroth AG

DOK-IWORKS-IL2GPRO*V12-AP01-EN-P
Rexroth IndraWorks 12VRS IndralLogic 2G PLC Programming System

li. = Breatpoiat sof
ADD o
L M
' 1@ — zreaipmint rmackes
ADD i
1 —
a0 T T
Fig.4-72: Example: Breakpoint set or reached

As soon as a breakpoint position is reached during the incremental process-
ing or the program sequence, a yellow arrow appears in the breakpoint icon
and the red shading changes to yellow.

hi [~ ]
fubinst
DIV fuhl
ivarz B livarl  outwar ery THls
z— eryd T# s L fubinsc.ivarl Tils
o
ivarl “ ivarl
1
Fig.4-73: Breakpoint positions in FBD
e
LD ivarz
DIV 2
5T erg T#Om=
5T fubinst.ivarl T#0ns
ChL fubinst()
LD fubinst.outvar
st exgs

Fig.4-74. Breakpoint positions in IL




ROBAVIGS, S.A.

RODAMIENTOS VIGO, S.A.

www.rodavigo.net +34 986 288118

Servicio de Att. al Cliente

DOK-IWORKS-IL2GPRO*V12-AP01-EN-P Bosch Rexroth AG 367/697
Rexroth IndraWorks 12VRS Indralogic 2G PLC Programming System

4.7 GVL Editor

Editors

= A breakpoint is automatically set in all methods that can be called.

For this reason, if a method managed by an interface is called,
breakpoints are set in all methods that appear in function blocks
that implement this interface as well as in all derived function
blocks that "record" for this method.

If a method is called by a pointer to a function block, the break-
points are set in the method of the function block and in all of the
derived function blocks that record for the method.

The editor for global variable lists (GVL editor) is a declaration editor to cre-
ate and edit . It functions based on the current
settings in the and is displayed in online mode
as described for the

The declaration has to begin with "VAR_GLOBAL" and end with "END_VAR".
These keywords are automatically available.

Valid of global variables are inserted in between.
G¥I1[DCC_Control_01: Logic: Application] S
= 1| VAR GLOBAL -
z glob_iVar: INT;
3 glob_bVar: BOOL:
4 glob_stWar: STRIHG:
5| EHD VAR
1
Fig.4-75: GVL edifor
4.8 Library Manager
4.8.1 Library Manager, General Information

The library manager integrates and manages libraries in the project.

Installing libraries, like defining library storage locations (repositories), is done
in the

This dialog can be opened using the command of the same name in the
"Tools" menu (by default) or in the "Library Manager" dialog.

In the project, the library manager can be inserted with either global access in
the "General module" folder or application-specific with the "Add" dialog.

At each of these positions, only one library manager per level can be inser-
ted. The entry has the name given In the "Add object" dialog.
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Editors &m Project Explorer

= @ DCC_Contral
I3 General madule folder
=i DCC_MotionContrall

[ - n Application
........... @ MicvarGilobal
----------- @ User/aGlobal

" fELibrary

bl anager

=328 Task Configuration
@ MotionT ask.
B @ FleT ask
Fig.4-76: Library manager in the Project Explorer

The library manager opens via "Open" or a double-click.

Compiling errors with regard to the library manager are output in the "mes-
sage window".

For general information on the

4.8.2 Editor Window of the Library Manager

The library manager opens via "Open" or double-click on the object entry.

> Library Manages[Mic1: Logic: Application] | - % .
Name: [ Namiespace [ Effective version | Al addibrar.,
16238l [nStandard = laStandard, 3.4.2.0 (System) loStandard 3420 'Em- = ﬂjﬁ ¥
T oG Gtandird = Staniard, 3.4) g Removs Lbrsy
b 12200 o
v L 10,0 { St} 10,8.0.0 Placahilders.,,
-5 PIL_FIELDBLS 0.0 (Systzm) .20 Detals..
. 22 :
4 -
1%
) PUCOPENLIE =ML_PLopen, 12:2.0,0 ML_PLCopen Lbrary repositany,
8 FIL_IHUINE = 1L Triine, 12:2.000 (Svstem) FL Triins =l ' -
+ |0 Bistable Function Blocks :
= 1) Counter
1B — m
|E Ty ount Down on rmn\;:éagc‘
18] crup Load Start Value S17]
+ 0 Miscellaneous Start Yalue —D e g ol
e | String Finctionss ‘Counter reached 0 —LoAn - E@ o ek —
+ 12 Timer Current Counter Valus — gy
+ 120 Trigger I )
 Inpatsfoutputs | Graphical Documentatin |
| FUNCTION_8LOTK CTD
‘Neme Type nhertedfrom Address Inital (Comment
@  8ooL Count Dawin on ising edge
| |toap sooL Load Start Value
| Py wiorD Start Value
| |le 8oL ounter reached &
v WORD & Counter Value
Fig.4-77: Library manager editor window
Structure of the editor window  The upper section of the library manager displays the cur-

rently included in the project. The following information is given:
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Editors
Name: Title, version and the company name (optional) as defined in the
"Summary" dialog in the when the library was

created.

Namespace: The default for the library namespace is <LibraryName> un-
less it was explicitly defined with another namespace in the library informa-
tion of the library project.

has to precede the function block identifier if
there is supposed to be unambiguous access to a function block that is pres-
ent in multiple instances in the project.
The default namespace in an included library can also be modified for local
use in the project. This is done in the "Properties" dialog, see

Further information on

Effective version: indicates the version of the library currently used in the
project according to the definition in the

Libraries automatically added to the project are displayed in a gray font.
Those that are manually added (Add library...) are shown in black.

Anicon in front of the library name indicates the type of library:

{1 IndralLogic 2G library (contains version information)

g | Referenced library, automatically included.

The referenced library file could not be found or is not a valid library file
- (see the corresponding message in the "library manager” category in
o the message window).

In this case, see:

If a library has dependencies on other libraries (

), these - when they are found - are also automatically included and dis-
played with a =1 preceding symbol in a subbranch of the item. Such a sub-
tree can be expanded or collapsed either with a plus or a minus sign. For an
example, see the "ML_Base" library.

N MNarmsERace | Effective version |

]
TSR | S
—l'i:. K EEE

ad

Fig.4-78: Referenced libraries

In the lower left section of the editor, the function blocks of the currently se-
lected library are also displayed in a tree structure. The usual sorting and
search functions are available in a menu bar.

The following tabs are found in the lower right section:

Documentation: The components of the currently selected library function
block at the left are displayed in a table with (variable) name, data type and
the comment that might have been included in the declaration when the

. Adding such a comment is an easy way to auto-
matically provide the user with documentation of a function block.
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Editors
- Lib, Project l'.'."-l'ﬂ_|
= General module foidst 1 FUNCTION_BLOCK CTD
35 Bistable Function Biocks | | = 2 (* Counter Douw
E_G Cowmat : LV 15 decregpented by -1 3f C0 has & wising odge.
_3] LCTD[FB} 4 Q 12 TBOE, 1f CF reached 0.-%)
——Z] CIU{FB] - T VIR _IHPUT
—— =] CTUD {FB] £ CDh: BOOL: (= Chint Down on Fising sdie #)
= 7 Mizcellansous 7 LOAD: BOOL; = Load Start Valus *)
) Sting Functions g BV: = * Ztart Velus =) \ o
F 3 Timet ol i - ; ’ Library project, o
=y Trge Ly ; comments in declaration parnt
—— [ Litwary Indo i "0 BAOL: {* Counter reachsd § *}/
=—{[E] DCLC_Cortal i¢ CV: WBHD:; (= Current Counter Valus =)
13 EHD VIR
= 1 UER
Az H: BOGOL: {* Variabls For (D Edge Detection®)
ok
|
= 1 IF LOAD THEH
- CV = PV:
= 3 ELSTF (CD #HD WOT (M)) @D (CV > 0] THEHW
3 LY := CV - 1: '
= END IF
5 Q== (CV == 0):
7 = CDr

LG Bibliotheksverwalter[DCC_Contiok: Logic: Application] |
- a8: |s5tandard, 3 g InStardard

Library included in project,
Tah Documentation’

e Weme Type Inherited from Address Initisl Comment
<E] au cD BOOL Count Down on r|slng edge
2] aw LOAD BOOL Load Start Value
-5 Mscelinsols PV WORD Start Value
#* 12 String Functions Q BOOL Counter reached 0
* =) Timer : -
L= v WORD Current Counter Value
* - Trigger -
Fig.4-79: Example of commented library function blocks
Inputs/outputs: The components of the currently selected library function
block at the left are displayed in a table with (variable) name, data type, ad-
dress, initial value and comment as defined in the library.
Graphical: Graphical display of the function block.
Buttons and commands inthe li-  The following commands are available in the editor window if one or multiple

brary editor window  entries in the tree of included libraries are selected. Some of them can also
" menu which appears in the menu bar by default
when working in the library manager:




vAR

Servicio de Att. al Cliente

DOK-IWORKS-IL2GPRO*V12-AP01-EN-P Bosch Rexroth AG 371/697
Rexroth IndraWorks 12VRS Indralogic 2G PLC Programming System

Editors

Add library..., page 227, to include a library in the project. Prerequisite: the
library has to be installed in the system.

Properties..., page 230, for settings on the namespace, and - in case the li-
brary appears later as a "referenced library" in another project - for settings of
version management, display and access.

Remove library: The libraries currently selected in the list of included libraries
are removed.

Library repository..., page 185, to define storage locations and install or unin-
stall libraries.

A corresponding message appears if an attempt is made to add a library that
is already included in the project.

48.3 Library Manager Menu

The currently available commands of the library manager are located at the
right margin of the opened "Library Manager" dialog.

is highlighted in the Project Explorer,
the "Library Manager" menu appears in the menu bar by default.

Installing libraries, like defining library storage locations (repositories), is done
in the .

48.4 Library Information
Icon: i |

In addition to the project properties, the "Project Information" dialog (Library
Info, Project Information) also contains other information (e.g. access rights,
version number, author, company, statistics on the project objects, etc.). It
has already been added as an object in the POU window in a "default proj-
ect".In this case, the "Standard.library" library.

They are required by the user even if he does not want to
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-5 Emor-/Diagrostics Metmon Company: iSystem
- i Global Yanables List
w2 Interrial (Do ot usel] Title: [ML_Base MLE_LB5
-5y IP-Settings e
M Others ¥ersiom !ll.z.l].l] ¥ Releaced
- ) SystemTime Library Categoties: Imdraﬁ'htim MLC|Base |
-y Target

Librans M anager
GetBooleanProperty [FLIM]
FetCampary [FLUM]
GetMumberProperty [FUM]
GetTextProperty [FUM]

Diefault namsspacs! iML_Base

GetTitle [FUM)
Feterzion [FLIN]
GeterzionProperty

o

(= [
77
o
2
=3
(=]

F- BEC: Cantral_01

Buthor! iBDsdﬂ Rexroth Electric Drives and Controls GmbH
Descriphion: _aJ
The figlds in bold letters are used to identify a library,
IV Butarmatically Generate POUS For properky access
o I “Zancel: j

Fig.4-80: "Library Info” dialog

To open the dialog, double-click on the object in the Project Explorer or use
the "Open" command.

Note the option to access library information externally using the
and additionally created functions (see below).

Automatically generate POUs to access the properties:

If this option is enabled, the POU objects of type function are automatically
created in the POUs window which can be used to access project properties
from the application program.

In this case, special functions are generated for the 'Company', 'Title' and
'Version' properties (GetCompany, GetTitle, GetVersion).

To explicitly access defined properties, a corresponding function is available
for each property type (GetTextProperty, GetBooleanProperty, GetNumber-
Property, GetVersionProperty). In this case, call the corresponding function
and transmit the "Properties" key (as defined in the tab) as input
so that the property value is returned.

For an example, refer to
Example:

The following property is defined in the "Properties" tab: Key = nProp1, Type
= Number, Value = 333. To receive the value in the application program, call
the "GetNumberProperty" function; e.g.. showprop:=GetNumberProper-
ty("nProp1"). In this case, "showprop" has to be declared as DINT.

There are four tabs available for the information categories "File", "Summa-
ry", "Properties" and "Statistics".
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1. File

Bosch Rexroth AG 373/697

Last sawed with:  indralogic

Editors
T |
‘Location: Ci\Dokumente und Enstellungentvolkhamm!Eigens Dab

Sizes 35.63 KB{36,458 bytes)
Crested: Tuesday, April 05, 2011 2:34:49 AM
Changed: Tuesday, April 05, 2011 2:34:49 AM
‘Last aocess:! Tuesday, &pril 05, 2011 2:34:49 AM
Attributes: ™ Readorly 7| Hidden

¥ | archive ™| System

v automatically generate POUSs For property access

8]4

Cancel

Fig.4-81: "Library Info” dialog, File

The following project file properties are displayed: Name, Location, Size in
KB, MS-DOS name, Created, Changed, Last Access and name of the profile

with which the file was saved last.

In addition, it can be seen which of the following file attributes are currently
set. Read-only, Hidden (i.e. not visible in the Explorer by default), Archive
(prepared for archiving), System (system file). By default, these attributes
cannot be edited here (see the file attributes in the Windows Explorer).
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e |

Fle  [Summary J properties | Statistics |

Company: System

Title: ML_Base MLC_LE5S

Yersion: 11.2.0.0 ¥ Beased
Library Categories: p.rrdTanTnticln MLC|Eaze _J
Default namespacs: |ML_E@ase

Author: |Eh:|sn:h Rexroth Electric Drives and Controls GrbH
Descripkion: :I

[~

The fields in bold letters are used ko identify a library,

v automatically generate POUSs For property access

(0] 4 Cancel

Fig.4-82: "Library Info” dialog, Summary

The following library can be stored here: Title, Version, a Default namespace,
the Author, the name of the Company and a short Descripfion. This informa-
tion is automatically available as a "Key" in the 'Properties' tab (see below).

Note the following for library projects, page 83: If a project is to be used in
other projects as a library, at least the following has to be entered here: a
Title, a Version number and the Company name.

A library file that includes this information can be on the

' in the projects. In addition to category, the company
name is used for sorting in the "Library Repository" dialog. As an option, "De-
fault namespace", "Author" and a short "Description" can also be specified to
be saved as library project information.

If a default namespace is not defined, the name of the library file is automati-
cally the namespace.

Assignment to a category:
Assigning a library to a category is also used for sorting.

If no category is explicitly given in the library information, the library is as-
signed to the "Other" category. If it should belong to another category, that
category has to be defined.

One or multiple external description files in XML format are used to define li-
brary categories. To assign the library, either one of these files can be called
to provide the category or another library file can be called that already in-
cludes this information on the categories from a description file.

Use the [I] button to open the Library Categories dialog:
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1F this project is used as a ibrary, & wil sppesr under the following categories: :
Indrabiotion MLC|Base - add> |

Fram Dissctiption File. ..
Fram Gther Library...

[o]4 | Cancel |

Fig.4-83: Dialog to select library categories

<Add> opens a menu to select whether the category information should be
retrieved

®  From Description File... or
¢  From Other Library...

In both cases, the default dialog for browsing for a file appears. The filter is
set to * libcat.xml or *.library.

The categories from the category description file or the library are listed in the
window.

Delete those ones not needed with <Delete>.

Further categories from other sources can be added in the same way. If the
list contains all of the desired categories, confirm with <OK> to close the dia-
log and to enter the categories in the 'Library Categories" field in the "Library
Info" dialog.
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3. Properties

e |

oot ==

Fle | Summary [Properties d statistics |

—Propertes

key Value _Type —
Suthor Bosch Rexrobth Blect...  Text

Company Syskem Texk
DefaultMamespace ML_Rase Text
Description Texk

Released True Boolean

Title ML_Base MLC_L65 Text

Yersion 11.z2.0.0 Yersion

v automatically generate POUSs For property access

(0] 4 Cancel

Fig.4-64: "Library Info” dialog, Properties

Define the key for specific file properties here. These can then be used in
user-specific external programs to externally control the respective proper-
ties.

tab is provided as "key". The property
names are used as key names, "Text" is automatically set as the data type
and the "Values" consist of the texts entered in the "Summary" tab. However,
other keys can be added explicitly (see the following).

Adding a key: In the Key field, enter a name and select the desired data type
from the Type: list (possible data types: text, date, number, true/false, ver-
sion). In the Value: field, enter the desired value which has to be compatible
with the data type. Use the Add button to apply the new key to the Properties
list.

Editing a key: Select the key in the "Properties" list from the selections in the
"Key" column and modify the key attributes as desired in the input fields
above the list. Then use the Modify button to apply the changes to the "Prop-
erties" list and, for the keys affected, to the "Summary" (!) tab as well.

Removing a key: Select the key in the "Properties” list from the selections in
the "Key" column and click on Remove.
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T |

Number of objects: 974

| Objeck type | count | -
£ fpplcatinn 1

 oevice 4

*gour il

IFolder 29

7 'get" accessor 376

fd ciohal Variabls List 14

5; Interface property a09

@Lil:urarwg.f Manager z —
fraMethad 66

El[l Plc Logic 1
e "

v automatically gererate POUS For property access

(0] 4 Cancel |

Fig.4-85: "Library Info” dialog, Statistics

This dialog shows the number of objects) in total that can be used per object
type (Number).

4.8.5 Library Info and Access Functions
Library Info and Access Functions, General Information

Information is saved in the "Library Info Object" of the library when creating a
library.

= As each library contains this object, the namespace followed by a
"." has to be specified for differentiation purposes.

The user can access part of this information via automatically generated
functions.

As example library, the BASELIB, namespace ML_Base is used in the char-
acteristic ml_base_mic_I65.

The following functions might be interesting for the user:
Functions without input parameters

Functions with input parameters (key)
[ ]
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= 3 nibee ks

GetBooleanProperty

General:
1Ay

iumbarProparty Memespoce: | TTNERTD £ 5 Tk :]

extProperty Default lbrary;  [ML_Base_MLC L85, 12.0,30.0 (¢ € Newest versen alyay
o _Base_MLC_LGS, y

ersion

: Visibility :

'ersionProperty
+ ) DataTypes IF the current project is referenced as a fibrary by another project:
*a FJ?OY-,fDi‘f;I‘IGS(E% He WV publish all TEC symbals to that project asiF this reference would have been included there directly,
* ) Global Yariables Lisk
* (2 Inkernal (Do not use!) I Fide this reference in the dependency tree.
+* ) IP-Settings
+-) Others
+-I) SystemTime Cancel |
+-0 Target
Fig.4-86: Access functions of the ML_Base library
GetCompany
Brief description  The GetCompany function responses with the group affiliation of the library.
Library Range
ML_Base
Fig.4-87: Library assignment

Interface description

GetCompany
GetCompany| WSTRING

Fig.4-88: "GetCompany" function
Name Type Comment
Function value GetCompany | WSTRING Group affiliation of the library, e.g. "sys-
tem"”
Fig.4-89: "FUN GetCompany” interface

Implementation example:  Example in ST

wsText:= ML_Base.GetCompany();

GetTitle
Brief description  The GetTitle function replies with the library title.

Library Range

ML_Base
Fig.4-90: Library assignment

Interface description
GetTitle
GetTitle]  WSTRING

Fig.4-91. "GetTitle" function
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Name Type Comment
Function value GetTitle WSTRING Library title
Fig.4-92: "FUN GeflTitle" interface

Implementation example:  Example in ST

wsText:= ML_Base.GetTitle();

GetVersion
Brief description  The GetVersion function replies with the library version.
Library Range
ML_Base
Fig.4-93: Library assignment
Interface description
Getversion .
GetYersion _VERSION
Fig.4-94. "GetVersion” function
Name Type Comment
Function value GetTitle VERSION Exact library version
Fig.4-95: "FUN GetVersion” interface

Implementation example:  Libraries also develop further.
This information ensures that a certain functionality is available.
This function can thus replace the version function in IndraLogic 1.x.

Example in ST:
VAR

uVersion: VERSION;
END_VAR

uVersion:= ML_Base.GetVersion();

VERSION is a system-individual structure to which the
Q ° major build number,

° minor build number,

®  service pack number and a

e  patch number

of the library are assigned.

GetBooleanProperty
The "GetBooleanProperty" function outputs "Released" TRUE with the key.
Otherwise, it outputs FALSE.

Library Range

ML_Base

Fig.4-96: Library assignment
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GetBooleanFroperty
WSTRING _ [stKey GetE‘.DDIeanF‘ererty_B 0oL
Fig.4-97: "GetBooleanProperty” function
Name Type Comment
VAR_INPUT stKey WSTRING Key of information to be read
Function value BOOL Desired information
Fig.4-98: "FUN GetBooleanProperty” inferface
GetNumberProperty Irrespective of the key, the "GetNumberProperty" function outputs "0".
Library Range
ML_Base
Fig.4-99: Library assignment
GetNumberProperty
WETRING _ |stkey GetMum berPerert\,f_DINT
Fig.4-100: "GetNumberProperty"” function
Name Type Comment
VAR_INPUT stKey WSTRING Key of information to be read
Function value DINT Always "0"
Fig.4-101: "FUN GetNumberProperty” inferface
GetVersionProperty
Brief description ~ The "GetVersionProperty" function reads the version number from the cur-
rently available library.
Library Range
ML_Base
Fig.4-102: Library assignment
Interface description
G etVerSiDnPerert\__,r
WSTRING _ |stkey GetVersionProperty] VERSION
Fig.4-103: "GetVersionProperty” function
Name Type Comment
VAR_INPUT stkey WSTRING Key of information to be read
Function value VERSION Desired information
Fig.4-104: "FUN GetTextProperty” interface
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VERSION is a system-individual structure to which the
Q U major build number,

U minor build number,

®  service pack number and a

e  patch number

of the library are assigned.

Implementation example:  Libraries also develop further.
This information ensures that a certain functionality is available.
This function can thus replace the version function in IndraLogic 1.x.

Program MotionProg
= 2 ViR
wztrFey: WSTRING:= { 1)

: wsrrVersionProp: VERSION:
: EHD VER
4 | »

=—
wstr¥ersionProp:= HL Bese,GetVersionProperty{watrKey):

$ \wstricey WITRING "yersion"
= @ wstrVersionP... VERSION
@ uiMajor LIMNT 12
@ uiMinor LINT i}
@ uiService .. UINT 30
@ uiPatch UINT a
(1) Namespace
GetTextProperty Fig.4-105: Implementation example in ST

Brief description ~ The "GetTextProperty" function reads the subsequent information from the
currently available library.

e  Author

o Title

e  DefaultNamespace
e Company

Library Range
ML_Base
Fig.4-106: Library assignment
Interface description
GetTextProperty
WSTRING_StKE}-‘ GetTextPerert}-‘_WSTRING
Fig.4-107: "GetTextProperty” function
Name Type Comment
VAR_INPUT stKey WSTRING Key of information to be read
Function value WSTRING Desired information
Fig.4-108: "FUN GetTextProperty” interface
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Implementation example:  The subsequent table contains the keywords and function values.

Keyword Function value

Author Bosch Rexroth Electric Drives and Controls GmbH
Title ML_Base

DefaultNameSpace ML_Base

Company System

Fig.4-109: Keywords and function values

4.9 Network Variable List Editor

The NVL editor is a declaration editor to create
. It works based on the current and in online
mode and nenerallv descrihed for the

The declaration of the network variables have to begin with the keyword
"VAR_GLOBAL" and end with "END_VAR". These keywords are automatical-
ly specified.

Valid of global variables are inserted in between.

MY¥YL32[BRC_MotionControl_1: Logic: Application]

1 A This global vwariable list is received viz network
S Bepder: ®WL521 [BRC-Control 1r Logic: Application]
A8 Protocol: UDEP

glob_intwar:THT:

glob_boolvar:BOOL ;

glob_stringvar:STRIHG:
EHD VAR

L e e T T o v I

Fig.4-110: NVL edifor

4.10 Recipe Manager
4.10.1 Recipe Manager, General Information

The Recipe manager provides functions to manage user-defined variable lists
called recipe definitions.

A recipe definition is a table with a variety of columns (Recipes) and
lines(Variables) in which value sets can be defined for the variables. Use
such recipes to set and monitor the variables on the control.

Recipe definitions can be read out of the control and described.

Recipe definitions can be saved in files and loaded again from the files.
These actions can be taken using visualization elements that have to be con-
figured accordingly.
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If the recipe manager is located on another control than the appli-
Q cation to which the recipes are applied, the data server is used to
) write or read the recipes.

Reading and writing take place synchronously in this case, i.e. all
variables in a recipe definition are updated at the same time.

Call g_RecipeManager.LastError after reading and writing
are completed to check whether the transfer was successful
(g_RecipeManager.LastError=0 in this case).

The recipe manager is added in the Project Explorer below an application.

To do this, highlight the application node and select Add » Recipe manager
in the context menu.

The "Recipe manager" object is also available in the "PLC objects" library in
the "VI logic objects" folder.

When creating the recipe manager, the following dialog opens which contains
the initial settings for the recipe manager.

Hecipe Manager[BRE_MolionControl_1: Logic: Apphcation]

Storage ]
Storage Type ITE:-!"LIB' _"J
Fibe Fathy 1': ‘Dokumente und Emnsteluinger’valkhamm\Eigens ;
File Extensior: J tutrecipes
— Sepasator
" Tah " Samicolon C Eomma
1= Epame fa -= & |
fvailable Colrins |+ | | setected Cobmins
".'Q Minmal % ahue "$ Yarable
1 il Ve 2 | Tupe
B P blame
*ﬁ Currenty alue
e | +$ Conmert
p | Cawn |
Fig.4-111: Initial settings of the recipe manager

Storage Type: Recipe definitions can be stored as text or binary information.
File Path: Storage location; can be selected.
Separator: Between the stored data elements; can be selected.

Available / Selected Columns: The desired recipes can be selected from the
available columns (recipes). The columns can be changed in their sequence.

The initial settings can be saved as "defaults".
Multiple recipe definitions can be added below the "Recipe Manager" object.
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A recipe definition along with the recipes internally defined is displayed as ta-
ble in the and it can be edited there.

Recipe Definition

Recipe definition

The recipe manager manager one or multiple recipe definitions.

A recipe definition contains a user-defined list of variables and one or multiple
recipes (value sets) for these variables.

By using different recipes, one set of variables on the control can be as-
signed in a single action using another set of values.

A recipe definition must be added as object below the "Recipe Manager" ob-
ject in the Project Explorer. To do this, highlight the "Recipe Manager" object
and select Add » Recipe definition... in the context menu.

The "Recipe Definition..." object is also available in the "PLC objects" library
in the "VI logic objects" folder.

When a recipe definition object is highlighted, the related editor can be
opened by double-clicking on the object.

[+

INo et
=1 3] BRC.

antrol

4 General module folder
= BRC_MaotiomCoritral 1

2] Logic
=i} Application
e ﬁ DiakaServer

@ MicvarGlobal

W Uzer¥arGlobal

% Librany Manager
Z] FE1(FB]
_‘;'] MaotionProg [FRG]
ﬁ PlzFrog [PREG)

=

4, Pecipe Managsr

Contial_1; Loge: Application] 4» X

EIFIC_M olionControl_1: Logic: Application: Recipe Manager]

Yariable Type | Name: | Comment Minmnal Vahee | Madmal Vakie Current Vakie | Warning
MotionProgvar INT Stock | Storage cont._ 0 3 ¢Onliremode_ 3
MolonPmogerg  INT Compl., Storage result 0 50 <Dnliremods:. 35

Bernes (defaut Berme (unes

Recyps ranager

3, el

3, Re (2 =

o |

M~ Recwe dafinitions

Fig.4-112: Recipe definition, edifor window
The title bar of the editor window includes the name of the recipe definition.

Multiple project variables for which one or multiple recipes are to be created
can be entered in a table.

At first, the editor contains only one empty line.

Variable Enter the path of a project variable, e.g. "MotionProg.ivar", into

the field in the "Variable" column.
In editing mode, double-click to access the field.

The input assistance can also be accessed with the @ but-

ton.
Type Variable data type, entered automatically.

Name A symbolic name can be added to the variable (optional).

+34 986 288118

Servicio de Att. al Cliente

Minimal Value
Maximal Value
Current Value

Recipe name

Minimum value range that may be written on the variable.
Maximum value range that may be written on the variable.
Current value in online mode.

For each recipe within the recipe definition, there is a table col-
umn titled with the recipe name.

To add another line at the end of the list for a variable entry, use the menu
option VI logic recipe definition » Add variable in the main menu. To delete
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one or multiple highlighted lines, use the menu option VI Logic recipe defini-
tion » Remove variables. Alternatively, execute both menu options via the
context menu.

I= For more information on the recipe commands, see

Create or remove a recipe in offline mode.

® To create a recipe, click on VI Logic recipe definition » Add recipe in the
main menu.

e  Toremove a recipe, click on VI Logic recipe definition » Remove recipe
in the main menu.

Another column is then added at the right end of the table, titled with the

. The
fields in the recipe column can then be filled with variable values. This way,
several value sets can be prepared for the same variables.

In online mode, the recipes can be managed via "Visualization elements"
(creating, reading, writing, saving in a file, loading from a file); see

The following actions can be taken with regard to a recipe:

Create recipe
(=Add recipe)

A new recipe is created in the indicated recipe definition.

Read recipe

The current values of the variables in the indicated recipe definition are read by the
control and written into the indicated recipe. During this procedure, the values are
saved implicitly (in a file on the control) while they are displayed in the recipe defini-
tion table in the IndralLogic recipe manager. The recipe managed in IndralLogic is up-
dated with the values from the control.

Write recipe

The values of the indicated recipe - as stored in the recipe manager - are written on
the corresponding variables in the control.

Save recipe

The values of the indicated recipe are saved in a file with the extension "*.txtrecipe".
The file name has to be defined. To do this, the default dialog to save a file opens.

ATTENTION:

The recipe files used implicitly for clipboard functions while reading and writing may
not be overwritten. That means that the new file has be named different from

<Recipe name>_.<Recipe definition name>.txtrecipe!

Load recipe

The recipe saved in a file (see "Save recipe" above) can be loaded from this file
again. The default file selection dialog opens to select the file. The filter is automati-
cally set to include the file extension "*.txtrecipe". After it is loaded, the display of the
respective recipe is updated in the Indralogic recipe manager.

Delete recipe (=remove recipe)

The indicated recipe is deleted.

4.10.3 Recipe Manager in Online Mode

#Ht In preparation #HH#
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The ST editor is used to program objects in the IEC Structured Text program-
ming language (ST) or Extended Structured Text which provides additional
functions with regard to the IEC 61131-3 standard.

The ST editor is a text editor.

It works based on the current settings in the

Colors, line numbering, tab widths, indents, etc. can be set there.

Note that function block selection in texts is possible by pressing <Alt> while
selecting the desired section of text with the mouse.

The ST editor opens in the lower section of the editor window which also con-

in the upper section.

Note that if syntax emors are made while editing. Corresponding messages
are output in the message window. This window is always refreshed when
the editor window gets the input focus again (e.g. if the cursor is placed in an-
other window and then moved back in the ST editor).

386/697 Bosch Rexroth AG
Editors
4.11 ST Editor
4.11.1 ST Editor, Overview
fains the
4.11.2 ST Editor in Online Mode

Monitoring

In online mode, the editor for Structured Text (ST editor) provides views for

, i.e. displays and for
ues onto variables and expressions.

and val-

(breakpoints, single step processing, etc.) are

available. See

regarding how a

prepared value can be input for variables in online mode.
¢ Note that the editor window for an ST object also contains the declara-

tion editor in the upper section.
See also online mode in the

If the Inline monitoring function is not explicitly disabled (
), the current variable value is displayed in a small window after the

variable.

i Mic=Giohal

3] FE1FE)

=] PicProg{PRG)

& AcTask

5 ™ Mohon
-'_”I Technology

= 7 Apphcation [RUNNING]
Usedy aiGlicbal
Lway Manager
E] MotiorProg [PRE)

=228 Task Conhmssbon
£ MotonTask

= Profibus™ [Profies: DP Mastad
5 Profinet 10_Confrodler [Probinet 10 Con

BRL_MotionControl_1.Application.MotionProg

MaotionProg{BRC_MotionContiol_1: Logic: Application]

MatianT ask-[BHE__MntionE.t 1 b

Frinsel{ind Ay E=31): S/ cald
fhinstl.outy 1© 7

fhimsta{in] 28 F=:2): eld

erg 22 k=

erol 22 = fhitst2.ont] 22 §;

7 roreo
TR

Expression Type Valiss Prepared valus
P war T 1478
+ # ol FB1
= & fonst2 FEl
# =g INT 2
1 ivar] 14978 k= iver] 14976 |+ 1

Online view of a function block:

Fig.4-113:

Example: Online view of a MotionProg program with Inline monitoring

Monitoring is only possible in the view of an instance. No values are dis-
played in the view of the basic implementation. Here, the "Value" column
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contains the text "<The value of the expression cannot be read>" and three
question marks appear in the respective Inline monitoring fields in the imple-
mentation section.

Projert Fxrplure =l [ _ . -
hm 0 ml BRC_ MoliorCoriial 1: Lage: Apgication] ~ FBI[BRC_MotionControl_1: Logic: Application] 4§
[ Lj Genaral module falder BRLC_MotionCentral_1.Application.FB1
H =i [[E E_Fg_g_h:uolgll?gl:m’ﬂol_'l R yie | e Tt Yok,
-] S T— 4% in INT <¥alue of the expression cannot be retrisved. >
: E‘ﬂ&gﬂ“mﬂm *$ out UINT  =¥alue of Ehe expression cannot be retrieved. >
" i ar ; : = :
,- UsertaBlohl # Fhwar INT <¥alue of the expression cannot be retrieved. >
: .Il_ibfa_‘r.y'Maﬂa;er
FE1[FB)
MatiorFrog (PRG]
Pl=Prog (FRE] 1 out! W3 |i=inf w7 Pfhwvarl v |:[RETURM
(8 Task Configuration
: Motion T ask
PleT ask

Fig.4-114: Example: Online view of the implementation of the function block FB1

Forcing variables  In addition to a prepared value for a variable in the declaration section in
each editor, there is the option in the ST editor in online mode to click in the
implementation section (instruction) on the monitoring box of a variable which
opens a dialog in which the prepared value can be entered.

L avar[3TRL = ivar[3EET] + 1: // counter

] FFcall fhinstl wikth 11
& regudt Ibepstl
call apsn2 with 22

Loutf B Iy S pesuke fhingt 2

Prepare Yalue x|
Type: T
Current value: (31418
- What do you wank to do?

% Prapars a riew vahie for the et write o foroe oparation:

E R promarptiar el o v

" Release the Force,, without modifying the walue,

Release the Force and restore the watiable bojthe value it had
before fioreing it

(a4 I Cancel

Fig.4-115: Dialog - Prepare Value
The path, data type and current value from the variable are shown. By ena-
bling the corresponding item, decide whether

e a new value should be prepared that has to be entered into the editing
field

®  a prepared value should be removed
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e a currently forced variable should be released

e a currently forced variable should be released and its original value re-
stored before it is forced

The selected action is executed after the "Force values" command is called.
To do this, click on Debug » Force values in the main menu.

at the positions in a function block at
which a variable value can change or where the program sequence branches
or another function block is called.

In the following descriptions, "{BP}" indicates a possible breakpoint position:
e  Assignment: At the beginning of a line.

Note: If you use there is are
further breakpoint positions within a line.

® FOR loop: 1. Before the initialization of the counter. 2. Before the coun-
ter is checked. 3. Before an instruction.

{BP} FOR i := 12 TO {BP} x {BP} BY 1 DO
{BP} [statement1]

{BP} [statementn-2]
END_FOR
e  WHILE loop: 1. Before testing the condition. 2. Before an instruction.
{BP} WHILE i <12 DO
{BP} [statement1]

{BP} [statementn-1]
END_WHILE
e REPEAT loop: Before testing the condition.
REPEAT
{BP} [statement1]

{BP} [statementn-1]
{BP} UNTILi>=12
END_REPEAT
e  Calling a program or function block: At the beginning of the line.

® There is always a breakpoint position at the end of a function block. At
incremental processing (step-by-step), this position is reached after a
RETURN instruction.

Breakpoint in online mode: Disabled breakpoint: Program stop at a breakpoint:
1d1(y: .|l 1d1{);: 1 141} ;

|@ erxg 0 |i=Ehinst a (S :EI-J!j_lfl_l: =fhing z|@ krel 0 J:=thinst

TF hrrarEdl S8 THFE | TF herarE&IEE THR) 2l TF hwarFalsFl THFE

Fig.4-116: Breakpoint representation in ST
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Editors

= A breakpoint is automatically set in all methods that can be called.
Thus, the following applies: If a method defined by an interface is
called, breakpoints are set in all methods of function blocks that
implement this interface and in all function blocks derived that de-
fine the method.

4.11.3  Structured Text ST/ExXST
Structured Text ST/Extended Structured Text ExST

Structured text is a programming language that is comparable with other high
level languages such as C or PASCAL which allows complex algorithms to
be developed.

The program code consists of a combination of and
that can be executed conditionally (IF. THEN..ELSE)
or in loops (WHILE..DO).

Example.

IF value < 7 THEN
WHILE value < 8 DO
value:=value+l;
END_WHILE;

END_IF;

"Extended Structured Text (ExST)" is an IndralLogic-specific extension with
regard to the IEC 61131-3 standard for Structured Text (ST).

Examples:
[ J

Expressmns An "expression" is a construct that returns a value after being evaluated.

Expressions consist of and
can also be used as expressions.
An operand can be a constant, a variable, a function call or another expres-

sion.

Examples:

33 // Constant

ivar // Variable

fct(a,b,c) // Function call

a AND b // Expression

x*y) / z // Expression

real_var2 := int_var; // Assignment, see below

Evaluation of expressions  The evaluation of an expression is carried out by processing the operators
according to specific rules for the order of operation (priority of tasks). The
operator with the highest order is processed first, the operator with the next
highest order, etc., until all operators have been processed.

Operators with equal priority are processed from left to right.
In the following table, the ST operators are listed in order of their priority:

Operation Symbol Priority

Bracketing (Expression) Highest priority
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Editors
Function call IIi:Sut;]ction name (parameter
Exponentiation EXPT
Negation -
Complementation NOT
Multiplication *
Division /
Modulo MOD
Addition +
Subtraction -
Comparisons <> <=>=
Equality =
Inequality <>
Bool AND AND
Bool XOR XOR
Bool OR OR Lowest priority

Assignment as expression  As an extension with regard to the IEC 61131-3(ExST) standard, IndraLogic
allows the usage of assignments as expressions.

Examples:
int_varl := int_var2 := int_var3 + 9; // int_varl, int_var2 will get the value of (int_var3 + 9)
real_varl:= real_var2 := int_var; // correct assignments,

// real_varl, real_var2 will get the value of int_var
int_var := real_varl := int_var; // this will lead to an error, data type mismatch!
IF b = (i= 1) THEN
i =1+ 1;

END_IF;
Instructions

Control the instructions on how the given are to be processed.

The following instructions can be used in ST:

Instruction Example
Assignment A:=B; CV := CV + 1; C:=SIN(X);
( )

CMD_TMR(IN := %IX5, PT := 300);
and using the function block output A=CMD_TMR.Q;
RETURN;
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Assignment Operators

Editors

IF, page 393 D:=B*B;

IF D<0.0 THEN
C:=A;

ELSE D=0.0 THEN

END_IF;

CASE INT1 OF

1. BOOL1 := TRUE;
2: BOOL2 := TRUE;
ELSE

BOOL1 := FALSE;
BOOL2 := FALSE;
END_CASE;

J:=101;

FOR I:=1 TO 100 BY 2 DO
IF ARR[I] =70 THEN

J:=l;

EXIT;

END_IF;

END_FOR

J:=1;

WHILE J<= 100 AND ARR[J] <> 70 DO
Ji=J+2;

END_WHILE;

Ji=-1;

REPEAT

Ji=J+2;

UNTIL J= 101 OR ARR[J] =70
END_REPEAT;

EXIT;

CONTINUE;

label: i:=i+1;

JMP label;

Empty instruction ;

Fig.4-117:

On the left side of an assignment is an operand (variable, address) to which
the value of the expression on the right side is assigned using the assign-
ment operator :=.




RODAVISS, 8.A. www.rodavigo.net +34 986 238118

Servicio de Att. al Cliente

RODAMIENTOS VIGO, S.A.

392/697 Bosch Rexroth AG DOK-IWORKS-IL2GPRO*V12-AP01-EN-P
Rexroth IndraWorks 12VRS IndralLogic 2G PLC Programming System

Editors Also refer fo

° with the same effect.
Example:

Varl := Var2 * 10;

After this line is executed, "Var1" is equal to ten times "Var2".

Note the following functionalites  Further assignment operators that are not described in the 61131-3 standard
which are new compared to  (ExST):

Indralogic V1.x:
Set operator "S=": The value is "set". If it was once TRUE, it remains TRUE.
Program:

a S= b;

"a" receives the value from "b". If it was once set to TRUE, it remains TRUE
even if "b" becomes FALSE again.

Reset operator "R=": The value is "reset". If it was once FALSE, it remains
FALSE.

Program:

a R= b;

"a" receives the value from "b". If "b" was once set to FALSE, it remains
FALSE irrespective of the value of "a".

= Note this behavior in case of multiple assignments. All "Set" and
"Reset" assignments always refer to the last element of the as-
signment.

Example.

a S= b R= funl(parl,par2);

In this case, "b" receives the output that results when "fun1" is "reset",

BUT: "a" does not receive the "Set" result from "b", but the "Set" result from
"fun1" instead.

Assignment as expression, extension of the IEC 61131-3 standard (ExST):
Note that an assignment can be used as an
Calling a Function Block in ST

A (abbreviated as "FB") is called in ST based on the
following syntax:

Syntax:

<FB instance name>(FB input variable:=<value or address>|, <further FB input variable:=<value or address>
| ---further FB input variables);

Example:

In the following example, a timer FB (TON) with assignments for the parame-
ters IN and PT is called.

Afterwards, the output variable Q is assigned to variable A.
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RETURN Instruction

IF Instruction

The timer FB is instantiated in "TMR:TON:". Editors

The output variable is addressed based on the syntax "<FB instance>.<FB
variable>".

Program:

TMR(CIN = %IX5, PT = 300);
AZ=TMR.Q

Detailed information:
®

The RETURN instruction can be used to exit a function block, e.g. dependent
on a condition.

Syntax:
RETURN;
Example.

IF b:=TRUE THEN
RETURN;
END_IF;
a-=at+l;

If the value of "b" is TRUE, instruction a:=a+1 is not executed, but the func-
tion block is exited immediately instead.

A condition can be tested with an IF instruction and, depending on this condi-
tion, instructions can be executed.

Synfax:

IF <Boolean_expressionl> THEN
<IF_instructions>

{ELSIF <Boolean_expression2> THEN
<ELSIF_instructionsl>

ELSIF <Boolean_expression n> THEN
<ELSIF_instructions-1>

ELSE

<ELSE_instructions>}

END_IF;

The section in curly brackets {} is optional.

If <Boolean_expression1> returns TRUE, only the <IF_Instructions> are exe-
cuted and none of the other instructions.

Otherwise, the Boolean expressions that begin with <Boolean_expression2>
are tested successively until an expression returns TRUE. Then, all instruc-
tions between this expression and the next ELSE or ELSIF instruction is eval-
uated and executed accordingly.

If none of the Boolean expressions returns TRUE, only the <ELSE_instruc-
tions> are evaluated.

Example.

IF temp<17
THEN heating_on := TRUE;
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ELSE heating_on := FALSE;
END_IF;

Here the heating is switched on if the temperature falls below 17 degrees.
Otherwise, it remains switched off.

A CASE instruction can be used to combine several conditional instructions
with the same condition variables in one construct.

Syntax:

CASE <Varl> OF
<valuel>: <Instruction 1>
<value2>: <Instruction 2>
<value3, value4, value5>: <Instruction 3>
<value6 .. valuelO>: <Instruction4>

<value n>: <Instruction n>
ELSE <ELSE Instruction>
END_CASE;

A CASE instruction is processed according to the following scheme:

° If the variable <Var1> has the value <value i> hat, the instruction <in-
struction i> is executed.

e |f <Var1> does not have any of the specified values, the <ELSE instruc-
tion> is executed.

° If the same instruction is to be executed for multiple variable values,
write these values separated by commas and thus develop a common
instruction.

e |f the same instruction is to be executed for the complete value range of
the variables, write the starting and end values separated by two dots to
develop the common instruction.

Example:

CASE INT1 OF

1, 5: BOOL1 := TRUE;
BOOL3 := FALSE;

2: BOOL2 := FALSE;
BOOL3 := TRUE;
10..20: BOOL1 := TRUE;

BOOL3:= TRUE;

ELSE

BOOL1 :-= NOT BOOL1;
BOOL2 :-= BOOL1 OR BOOLZ2;

END_CASE;

Repeating procedures can be programmed with the FOR loop.
Synfax:

VAR INT_Var :INT; END_VAR

FOR <INT_Var> := <INIT_VALUE> TO <END_VALUE> {BY <Step size>} DO
<instructions>
END_FOR;

The section in curly brackets {} is optional.

® The <instructions> are executed as long as the counter <INT_Var> is
not greater than the <END_VALUE>. This is checked before the <in-
structions> are executed so that the <instructions> are never executed if
the starting value <INIT_VALUE> is greater than the end value
<END_VALUE>.
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Extension with regard to the IEC
61131-3 standard (ExST):

WHILE Loop

Editors
e When <instructions> is executed, <INT_Var> always increases by
<stepSize>.
®  The step size can have any integer value.

e |f this specification is missing, the step size is set to the default value
"1". This ensures that the loop comes to an end at some point, since
<INT_Var> can only become higher.

Example.

FOR Counter:=1 TO 5 BY 1 DO
Varl:=Varl*2;

END_FOR;

Erg:=Varl;

Assuming that variable "Var1" was preset with a value of "1", it assumes the
value "32" after the FOR loop.

= If <END_VALUE> equals the limit value of the counter
<INT_VAR>, e.g. if the counter - as used in the example above -
is of type SINT and if <END_VALUE> equals 127, an endless
loop results.

For this reason, <END_VALUE> may not receive a value that is
equal to the limit value of the counter!

The can be used in a FOR loop.

The WHILE loop can be used like the FOR loop, except that the abort condi-
tion can be any Boolean expression. That means that when the condition en-
tered is met, the loop is executed.

Synfax:

WHILE <boolean expression> DO
<instructions>
END_WHILE;

®  The <Instructions> are executed repeatedly as long as the <Boolean ex-
pression> returns TRUE.

e |f the <Boolean expression> is already FALSE at the first evaluation, the
<instructions> are never executed.

° If the <Boolean expression> never assumes the value FALSE, the <in-
structions> are repeated endlessly causing a runtime error.

= The programmer has to ensure that no endless loops are caused
by modifying the condition in the instruction part of the loop, e.g.
increasing or decreasing a counter.

Example.

WHILE counter<>0 DO
Varl := Varl*2;
Counter := Counter-1;

END_WHILE;

In a sense, the WHILE and REPEAT loops are more powerful than the FOR
loop, since the number of loop cycles does not have to be known before the
loop is executed.

In some cases, you will only be able to work with these two types of loops.
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Editors However, if the number of loop cycles is known, a FOR loop is preferred,

since it does not cause endless loops.

Extension with regard to the [IEC ~ The can be used in a WHILE loop.
61131-3 standard (ExST):

REPEAT Loop

The REPEAT loop differs from the WHILE loop in the abort condition being
checked only after the loop has been executed. As a result, this loop com-
pletely runs at least once irrespective of the abort condition.

Synfax:

REPEAT

<instructions>

UNTIL <Boolean expression>
END_REPEAT;

® The <Instructions> are executed as long as the <Boolean expression>
returns TRUE.

e |f the <Boolean expression> is already TRUE at the first evaluation, the
<instructions> are executed once.

° If the <Boolean expression> never assumes the value TRUE, the <in-
structions> are repeated endlessly causing a runtime error.

= The programmer has to ensure that no endless loops are caused
by modifying the condition in the instruction part of the loop, e.g.
increasing or decreasing a counter.

Example:

REPEAT
Varl := Varl*2;
Counter := Counter-1;
UNTIL
Counter=0
END_REPEAT;

Extension with regard to the IEC  The can be used in a REPEAT loop.
61131-3 standard (ExST):

CONTINUE Instruction
As an extension with regard to the IEC 61131-3 standard (ExST) the CON-

TINUE instruction is supported within . and loops.
CONT INUE causes the execution to jump to the beginning of the next loop cy-
cle.

Example:

FOR Counter:=1 TO 5 BY 1 DO
INT1:=INT1/2;
IF INT1=0 THEN
CONTINUE; // to avoid division by zero

END_IF
Varl:=Varl/INT1; // only executed, if INT1 is not 0"
END_FOR;
Erg:=Varl;
EXIT Instruction If the EXIT instruction appears in a , or loop, the inner-

most loop is ended irrespective of the abort condition.
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JMP Instruction

Comments in ST

Editors

The JMP instruction can be used for an unconditional jump to a program line
marked by a jump label.

Synlax:

<label>:

IMP <label>:

The <jump label> is any unique identifier positioned at the beginning of a pro-
gram line.

The jump instruction JMP is followed by a jump target input which has to
match the name of a defined jump label.

When the JMP instruction is reached, there is a retum jump to the program
line with label that matches the jump target.

= The programmer has to ensure that no endless loops are caused
by modifying the jump, e.g. by linking it to a condition.

Example:

i:=0;

Ilabel: 1:=1+1;
IF (i<10) THEN
JMP 1label;
END_IF;

As long as the variable i initialized with 0 has a value lower than 10, the con-
ditional jump instruction in the example above causes a repeated return jump
to the program line with the jump label and thus, repeated processing of the
instructions between the label and the jump instruction. Since these also con-
tain the incrementation of the variable i, it is ensured that i violates the jump
condition (exactly in the ninth query) and continues in the program sequence.

The same functionality can be achieved by a WHILE or REPEAT loop in the
example. In general, jump instructions can and should be avoided, since they
decrease the readability of the code.

Comments can be placed anywhere in the declaration editor or ST editor.
The following options are available to insert comments in Structured Text.

1. A comment begins with (* and ends with *). This allows to insert com-
ments with a length over several lines.

Example.

(*This is a comment.*)

2. One line comment (extension with regard to the 61131-3 standard): The
comment starts with // and ends at the end of the line.

Example.

// This is a comment

3. Nested comments: Comments can be inserted in other comments.
Example.

*

a:=inst.out; (* to be checked *)
b:=b+1; // increment

*)
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Editors In this example, the comment that begins with the first open parenthesis does

not end with the closing parenthesis after "checked", but with the parenthesis
in the last line instead.

4.12 Symbol Configuration Editor

The symbol configuration can create symbol descriptions for project variables
used to address these variables ("items") an external location, e.g. an OPC
server.

Refer also to the

The symbols for an application can be configured in the symbol configuration
editor that opens by double-clicking on the symbol configuration object in the
"Devices" window.

Symbols[DCC_Contol: Logic: Application] v X

Avadable variables Hefrach Selected varlables
Avaiable Items Access Rights Selactad [bems | Access Rights
= L} Variables
= |E] MotiorPrag
¥ en_PowerRAl 5700
¥ ex_GearInRA1 5000
# ex_GearOutRAl =0

2
# ivar_global ] = # ex_MoveVel¥Al 5001
=]

1w Y

P

¥ YactRAl 7540
# Vact¥al soi

2 Dota Types

FELELLESL

P Yoom¥Al ~o0

= @ |Useryarclobal
# ar_global 1/
™2 Data Types

£

< | ]

T~ Show libearies I avallable variables Instance Path; 1 EHESEN, LS sT N o ok
Display irvalid variables  Copy Instance Path

Changed symbal configuration will be transferred with the next download or online change

Fig.4-118: Symbol configuration editor

In the left section of the editor, the currently available variables of the applica-
tion are displayed in a tree structure with one node for variables and one
node for data types.

Indented below this node are the names of the blocks, global variable lists
(GVL) and data types, and in turn, below these are the names, data types
and access rights for the individual variables available here ("ltems"). Use the
<Refresh> button to update the tree with the currently valid variables.

= Under "Available variables" only those variables used in the pro-
gram are displayed.

POU variables are only visible if the respective POU is called in
the task editor.

GVL variables are only visible if these variables are explicitly used
in the program.

, @ non-compiled object can be
explicitly compiled and loaded to the control. Thus, all variables declared in
the object are available. Furthermore, the

is available. This results in the provision of unused variables in the
symbol configuration.

In the right section of the editor window, the variables currently selected for
the symbol configuration (Selected variables) are also displayed in a tree
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Editors

structure. For each one of these "items", a symbol definition is created and
exported to a symbol file. The <display invalid variables> button highlights all
variables in red that are currently invalid in the application, e.g. since their
declaration was deleted.

To add a variable or node currently selected in the left tree or in the right tree
or to remove an item from there, use the single arrow buttons between the
two windows. The double arrow buttons move the entire respective tree with-
out being selected first.

The access rights for a selected "item" can be modified in the right window by
clicking on the symbol in the Access Rights column.

Each click switches to the next possible symbol and the access right repre-

sented by it: ™ read and write access, “# write-only access, T read-only ac-
cess.

The option "Show libraries in available variables” specifies whether library
variables are displayed.

The Instance Path for a currently selected "item" is displayed in a field of the
same name in the lower section of the dialog. It can be selected and copied
to the clipboard using the <Copy Instance Path> button which can be useful
to enter a long path into an input field.

If the symbol configuration was modified in online mode, the modified appli-
cation can be loaded to the control using the <Download> button.

4.13 Sequential Function Chart Editor (SFC)

4.13.1  Sequential Function Chart Editor (SFC), Overview

The SFC editor is used for programming POUs in the IEC 61131-3
. The language is selected when a new POU object
is created in the project using the dialog under ... » Application » Add » POU.

The SFC editor is a graphical editor.
General settings on behavior and appearance are made in the

The SFC editor is located in the lower section of the window that opens when

an SFC object is edited.
The upper section contains the
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Fig.4-119: SFC editor

used in an SFC diagram are available by default in the SFC
menu as soon as the SFC editor is active.

They have to be arranged as a sequence of steps connected by transitions.
Parallel and alternative branches are both possible. Also see:

window.
Among other properties, the minimum and maximum activity time for a step
can be defined there.

can be used to monitor the processing of an
SFC diagram (e.g. step status, time monitoring, reset, etc.).

Call the commands for working in the SFC editor from the context menu or
the SFC menu available by default in the menu bar when the SFC editor is
active.

Basically, the same functionality is available: IndraLogic 1.x SFC proj-
ects can be imported.

° Editing has become easier, since each element can be selected and re-
nnsitinned individnallv (see

It is not necessary that the syntax in the SFC diagram is absolutely cor-
rect while programming.

e There is only one step type which combines the types used in
can now only be provided as POU objects and
are always assigned to a step in the step properties.

o can be used to structure an SFC diagram.
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413.2 SFC - Sequential Function Chart

The sequential function chart (SFC) is a graphically-oriented language that
allows to describe the chronological sequence of individual activities in a pro-
gram.

For this purpose, the actions, which are independent programming objects
written in one of the available languages, are assigned to steps. The process-
ing sequence is controlled by transitions.

(See
).

Init ﬂ—{ 5  |copyError |

[Tesc | | pararierz

T

Steps R |Tesc |

cl:'.iIEIIE

l b T Ta ] 1

Fig.4-120: Example of a step sequence in an SFC module

4.13.3  Cursor Positions in SFC
A possible cursor position in an is displayed by default with
gray shading in the when moving the cursor over the elements.

There are two categories of cursor positions: Texts and function block bodies.
In the following figures, note the possible positions displayed with gray shad-

ing:
1. Texts
| i
+u
i ]
e nanme, iranaition name
Branch0 1—1# | ace3z
. 4 _
Ekanch natne SGHON Sy
'—' b I l
g targed achion name

Fig.4-121: Possible cursor positions, texts:
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Click on a text cursor position and the text can be edited:

—I 4] | actll I

Fig.4-122: The action name was selected for editing

2. Element bodies

stepl —| i) | actl I
‘ action
Sty

td ]
tranaition

Bra. | i

branch ':|:' td ‘:i:' tal

[ ]
‘ Macro Count I

machd

Fig.4-123: Possible cursor positions, element bodies:

Click on one of the gray shaded areas and the element is selected. It is out-
lined by a dotted frame and displayed with red shading.

( ):

Init

T
N actl I
stepl

Fig.4-124: Selected step element

4.13.4  Working in the SFC Editor

Adding elements

By default, a new SFC POU contains an Init step and a subsequent transi-
tion. The following describes how further elements can be added, positioned
and edited:

Possible cursor positions: See

Navigation: Use the arrow keys to jump from the currently selected element
to the next or previous one.

can be added using the corre-
sponding default commands in the "SFC" menu.

Double-clicking on a step, transition or action element already added that
does not contain a reference on an existing project object opens a dialog to
assign such a reference.
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Selecting elements

Editing texts

Editing assigned actions

Cutting, copying and inserting ele-
ments

Deleting elements;

Editors

An element or text area can be selected by clicking on a possible
. Use the arrow keys to switch to the adjacent element. The selected ele-
ment changes its color to red. ( ).

Steps and transitions can be individually selected, repositioned, cut, copied,
added or deleted.

Multiple selection is possible as follows:

e Hold down the <Ctrl> key and click subsequently on the individual ele-
ments to be selected.

®  Press the left mouse button and to draw a rectangle (dotted line) around
the elements to be selected.

. Use the command Edit » Select all.

the editing field in which the text
can be edited opens immediately. If a text area is selected with the arrow
keys, the editing field has to be opened explicitly by pressing the <space
bar>.

Double-clicking on the action assignment in a step element (input, step or
output action) or on a transition element with an assigned action opens the
action in the respective editor. For example, double-click on the triangle dis-
playing an assigned output action in a step element.

Select the elements and use the respective command, "Cut", "Copy" or "In-
sert" (from the "Edit" menu in the default setting) or use the respective key-
board commands.

Note the following behavior compared to that in Indralogic 1.x:

e Add one or multiple element(s) and the clipboard content is added in
front of the currently selected position. If nothing is currently selected,
the content is added to the end of the diagram.

e |fa branch is added and the currently selected element includes branch-
ing, the branch added is positioned at the left of the existing branch.

e |f an action (list) is added while a step is currently selected, the new ac-
tions are added at the beginning of the action list for the step or if none
exists yet, an action list is created.

® |ncompatible elements during cutting/copying:

If an action (list) and an element that is not the step to which the action
belongs are selected simultaneously, a message appears: "The current
selection contains incompatible elements. No data is sent to the clip-
board."

The selection is not saved, cannot be inserted at another position or
copied.

® |Incompatible elements while adding:

If there is no step or another action list when inserting an action list, an
error message appears: "The contents of the clipboard cannot be inser-
ted at the current selection.”

If you try to add an element such as a step, a branch or a transition
while an action list is selected, the same error message appears.

Select the element(s) and use the "Delete" command or the <Del> key.

Poligono Indutrial O Rebullén s/n. 36416 - Mos - Espafia - rodavigo@rodavigo.com
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Deleting a step also deletes the assigned action list.

e Deleting the initial step automatically makes the subsequent step to the
initial step, i.e. the "Initial step" option in the step properties is enabled.

e Deleting the horizontal line in front of a branched area deletes all
branches.

e Deleting all elements of a branch deletes the branch.

4.13.5 SFC Element Properties

The properties of an SFC element can be displayed and edited in the "Prop-
erties" window.

Open this window via the command
(View » Other Windows > Element Properties).

Which properties are displayed depends on the currently selected element.
They are summarized in groups and the groupings can be opened and
closed using the plus and minus signs.

Note that it can be specified in the "View" tab of the
regarding whether a property can be displayed next to the ele-
ment in the SFC diagram.

The following includes all possible properties:

Element name, by default "<Element><consecutive number>" , e.g. step name "Step0", "Step1",
Name " " !
branch name "BranchQ" etc.
Comment Element comment (text), e.g. "Counter reset". Line breaks can be added with <Ctrl>+<Enter>.
For each SFC element, an implicit variable is created with the same name as the element.
Configure whether this flag variable is to be exported to the symbol configuration and which ac-
cess rights should apply for the symbol in the control.
Double-click on the field in the "Value" column or select the field and press the <space bar> to
open a selection list to set one of the following access options:
° No access: The symbol is exported to the symbol configuration. It is not possible to access
Symbol this symbol.
o Read; The symbol is exported to the symbol configuration and can be read on the control.
° Write: The symbol is exported to the symbol configuration and can be written on the control.
] Read/write: Combination of reading and writing.
By default, nothing is entered (empty field in the selection list). That means that no symbol is ex-
ported to the symbol configuration.
Fig.4-125: General properties
. The first step in an SFC
N diagram is preset. Note: If this property is enabled for another step, it has to be disabled for the
Initial step step that had this property before to prevent compilation errors.
Also note the command in this context.
Times: Timeouts in steps can be monitored using the "SFCError".

Minimum time period that the step should be active.

. Minimum active | Possible values: Time specifications based on IEC syntax (e.g. #8s) or

Variable of type TIME with initial value: #0s.
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. Maximum active

Maximum time period that the step should be active.
Possible values: Time specifications based on IEC syntax (e.g. t#8s) or

Variable of type TIME with initial value: t##0s.

. Define the to be executed when the step is active.
Actions:
Note the
L Step entry This action is executed after the step was enabled ("input action").

L Step active

This action is executed when the step is active and any possible input actions have already been
processed.

° Step exit

If the step is disabled, this action is executed in the following cycle ("output action™).

Fig.4-126: Special features

= Refer to the status of a step or an action from the respective
for more information.

Furthermore, you also obtain information on timeouts from

4.13.6 SFC Elements/Toolbox

The graphical elements for programming in the SFC editor can be added us-
ing the corresponding commands available by default in the
when the editor is active.

= The SFC toolbox is ### in preparation ###.

In addition, refer to the help page for

The following elements are available and described below:
b ’

[ ]

[ J

[ J

[ J

[ J

Step, initial step and subsequent | ong: FIF4

transition
is represented by a rectangle (box) that contains the step name

and that is connected with the subsequent transition via a line.

Stepd

l%lTransEl

Fig.4-127: Step and subsequent transition:
The frame of the initial step consists of a double line.
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